Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

| **DANGER** | indicates that death or severe personal injury will result if proper precautions are not taken. |
| **WARNING** | indicates that death or severe personal injury may result if proper precautions are not taken. |
| **CAUTION** | indicates that minor personal injury can result if proper precautions are not taken. |
| **NOTICE** | indicates that property damage can result if proper precautions are not taken. |

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

| **WARNING** | Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed. |

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Table of contents

1 WinCC/PerformanceMonitor - Installation Notes.................................................................5
   1.1 System requirements........................................................................................................5
   1.2 Performance data............................................................................................................8
   1.3 Licenses..........................................................................................................................10
   1.4 Installation basics..........................................................................................................11
   1.5 Installing PerformanceMonitor....................................................................................13

2 WinCC/PerformanceMonitor - Release Notes..................................................................15
   2.1 Notes on PerformanceMonitor......................................................................................15
   2.2 New functionalities.........................................................................................................17
   2.3 Service and Support......................................................................................................19
   2.3.1 Warnings..................................................................................................................19
   2.3.2 Customer Support......................................................................................................21
   2.3.3 Support Request.........................................................................................................23

3 WinCC/PerformanceMonitor - Documentation................................................................27
   3.1 Basics............................................................................................................................27
   3.1.1 Basics about the PerformanceMonitor......................................................................27
   3.1.2 Use in the WinCC environment..................................................................................29
   3.1.3 Objects in the PerformanceMonitor..........................................................................31
   3.1.4 Type and instance concept.......................................................................................32
   3.1.5 Output options for KPIs in Runtime..........................................................................34
   3.2 Elements and basic settings..........................................................................................35
   3.2.1 PerformanceMonitor Configuration Studio..............................................................35
   3.2.2 Managing the PerformanceMonitor Configuration Studio.......................................39
   3.2.3 Formula editor...........................................................................................................40
   3.3 Working with the PerformanceMonitor.........................................................................43
   3.3.1 Procedures for the KPI definition...............................................................................43
   3.3.2 Configuration support...............................................................................................43
   3.3.3 Connecting PerformanceMonitor with the Process Historian server .......................45
   3.3.4 Central Process Historian..........................................................................................48
   3.3.4.1 Management Console - Overview.........................................................................48
   3.3.4.2 Operating states of the Process Historian...............................................................50
   3.3.4.3 Central overview of the Process Historian Server...............................................52
   3.3.4.4 Configuring segments...........................................................................................53
   3.3.4.5 Compressing segments.........................................................................................55
   3.3.4.6 Backup of segments...............................................................................................56
   3.3.4.7 Restoring segments...............................................................................................59
   3.3.4.8 Setting segments "Offline"....................................................................................60
   3.3.4.9 Backing up the database.......................................................................................61
   3.3.5 Creating object types...............................................................................................65
   3.3.5.1 Basics of object types...........................................................................................65
Table of contents

3.3.5.2 Cyclic output of a KPI calculation in WinCC tag..............................................................67
3.3.5.3 Creating an operand type.............................................................................................71
3.3.5.4 Creating an operand formula.......................................................................................73
3.3.5.5 Creating a structured operand type..............................................................................74
3.3.5.6 Creating a KPI type........................................................................................................76
3.3.5.7 Creating equipment.......................................................................................................77
3.3.5.8 Creating the context information type...........................................................................78
3.3.6 Configuring object instances............................................................................................79
3.3.6.1 Assigning the KPI type to equipment.........................................................................79
3.3.6.2 Configuring a KPI instance........................................................................................80
3.3.6.3 Configuring an operand instance of the "Timer/Counter" type.................................80
3.3.6.4 Configuring an operand instance of the "Number" type.............................................81
3.3.6.5 Assigning parameters to an operand instance of the type "External counter"............83
3.3.6.6 Configuring context information.................................................................................84
3.3.6.7 Example: Using an operand of "Timer/Counter" type.................................................85
3.3.6.8 Example: Using an operand of the type "External counter"......................................86
3.3.7 Exporting and importing configuration data.................................................................88
3.3.7.1 Basics.........................................................................................................................88
3.3.7.2 Exporting configuration data.....................................................................................90
3.3.7.3 Importing configuration data.....................................................................................91
3.3.8 Access PerformanceMonitor controls with VBS..........................................................92

3.4 Outputting KPIs.................................................................................................................98
3.4.1 Basics on outputting KPIs..............................................................................................98
3.4.2 Controls for displaying the KPIs......................................................................................100
3.4.3 Configuring in the Report Designer..............................................................................102
3.4.4 WinCC PerformanceViewControl................................................................................102
3.4.4.1 Configuring WinCC PerformanceViewControl.........................................................102
3.4.4.2 Operating WinCC PerformanceViewControl in Runtime.........................................109
3.4.5 WinCC PerformanceGanttControl...............................................................................111
3.4.5.1 Configuring WinCC PerformanceGanttControl.......................................................111
3.4.5.2 Operating WinCC PerformanceGanttControl in Runtime........................................117
3.4.6 WinCC PerformanceTableControl................................................................................119
3.4.6.1 Configuring WinCC PerformanceTableControl.......................................................119
3.4.6.2 Operating WinCC PerformanceTableControl in Runtime......................................126
3.4.7 Outputting KPIs in the Information Server.....................................................................128
3.4.7.1 Creating a PerformanceMonitor report in the Information Server..........................128
3.4.7.2 Output of KPIs via Excel add-in.................................................................................131
3.4.7.3 Creating a custom template......................................................................................133
3.4.7.4 Example: Creating a custom template for outputting KPIs......................................134

3.5 Reference.........................................................................................................................151
3.5.1 Syntax for formulas.........................................................................................................151
3.5.2 PerformanceMonitor Configuration Studio.....................................................................152
3.5.2.1 Types.......................................................................................................................152
3.5.2.2 Instances................................................................................................................155
3.5.3 VBS Reference..............................................................................................................157
3.5.3.1 Methoden...............................................................................................................157
3.5.3.2 Properties...............................................................................................................164

Index........................................................................................................................................173
1.1 System requirements

Introduction

The following hardware and software configuration requirements must be satisfied for the installation of the PerformanceMonitor.

Note

WinCC/Redundancy is not supported by the PerformanceMonitor.

Hardware requirements

<table>
<thead>
<tr>
<th>PerformanceMonitor server</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Server: Dual core CPU; 2.5 GHz</td>
<td>Server: Multi core CPU; 3.5 GHz</td>
</tr>
<tr>
<td></td>
<td>Single-user system: Dual core CPU; 2.5 GHz</td>
<td>Single-user system: Multi core CPU; 3.5 GHz</td>
</tr>
<tr>
<td>Main memory</td>
<td>8 GB</td>
<td>16 GB</td>
</tr>
<tr>
<td>Hard disk</td>
<td>2 x 1 TB</td>
<td>3 x 1 TB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Client</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Client: Dual core CPU; 2.5 GHz</td>
<td>Client: Multi core CPU; 3 GHz</td>
</tr>
<tr>
<td></td>
<td>Single-user system: Dual core CPU; 2.5 GHz</td>
<td>Single-user system: Multi core CPU; 3.5 GHz</td>
</tr>
<tr>
<td>Main memory</td>
<td>2 GB</td>
<td>2 GB</td>
</tr>
<tr>
<td>Hard disk</td>
<td>1 x 40 GB</td>
<td>2 x 80 GB</td>
</tr>
</tbody>
</table>
Software requirements

<table>
<thead>
<tr>
<th>PerformanceMonitor server ¹</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows 7 Professional Service Pack 1 (32-bit / 64-bit)</td>
<td>Windows Server 2008 R2 Standard Service Pack 1 (64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Enterprise Service Pack 1 (32-bit / 64-bit)</td>
<td>Windows Server 2012 R2 Standard (64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Ultimate Service Pack 1 (32-bit / 64-bit)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Pro (32-bit / 64-bit)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Enterprise (32-bit / 64-bit)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 10 Pro (64-bit)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 10 Enterprise (64-bit)</td>
<td></td>
</tr>
<tr>
<td>SIMATIC HMI WinCC</td>
<td>V7.4</td>
<td>V7.4</td>
</tr>
<tr>
<td>SIMATIC Information Server (for generating reports)</td>
<td>2014 SP2</td>
<td>2014 SP2</td>
</tr>
</tbody>
</table>

¹ You can also install the PerformanceMonitor server on a WinCC client.

Note

Additional installation for Process Historian component

When you use the Process Historian component, you must ensure that .NET Framework 4.6.1 is installed on your PerformanceMonitor server.

<table>
<thead>
<tr>
<th>Client</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows 7 Professional Service Pack 1 (32-bit / 64-bit)</td>
<td>Windows 8.1 Pro (32-bit / 64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Enterprise Service Pack 1 (32-bit / 64-bit)</td>
<td>Windows 8.1 Enterprise (32-bit / 64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Ultimate Service Pack 1 (32-bit / 64-bit)</td>
<td>Windows 10 Pro (64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Enterprise (32-bit / 64-bit)</td>
<td>Windows 10 Enterprise (64-bit)</td>
</tr>
<tr>
<td>SIMATIC HMI WinCC</td>
<td>V7.4</td>
<td>V7.4</td>
</tr>
<tr>
<td>SIMATIC Information Server</td>
<td>2014 SP2</td>
<td>2014 SP2</td>
</tr>
</tbody>
</table>

Note

SQL Server

Audit V7.4 requires Microsoft SQL Server 2014 Service Pack 1 in the 32-bit version.

WinCC client without its own project

The installation of the "Editor and Service" component has not been approved on a client without a project of its own.

You cannot configure the PerformanceMonitor controls on a client without a project of its own. Configure the controls in the WinCC Graphics Designer on the PerformanceMonitor server.
WinCC Client with its own project

A WinCC client with its own project must meet the following requirements for installation of the PerformanceMonitor server:

- A Runtime license is installed.
- You have created a client project.
1.2 Performance data

The following values serve as a guideline and depend on the hardware used as well as the data change per unit of time.

**Recommendation: Use a maximum of 5,000 archive tags**

The following calculation examples show how you reach the quantity of 5,000 archive tags:

- **Example 1:**
  10 operands per equipment and 500 equipments
  
  \[ 10 \text{ operands} \times 500 \text{ equipments} = 5,000 \text{ archive tags} \]

- **Example 2:**
  20 operands and five items of context information per equipment and 200 items of equipment
  
  \[ (20 \text{ operands} + 5 \text{ items of context information}) \times 200 \text{ items of equipment} = 5,000 \text{ archive tags} \]

**Recommendation: Display the equipments in several runtime controls**

Three equipments with 10 operands each are calculated in the following calculation example. The values of the operands are collected with a cycle of one seconds.

If you display these three equipments in a runtime control with an evaluation time of one hour, 108,000 values have to be calculated and displayed.

### Example hardware configuration

The determined performance data are based on the following hardware configuration:

<table>
<thead>
<tr>
<th>Processor</th>
<th>Intel I5-3470 (Quad Core with 3.2 GHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main memory</td>
<td>16 GB</td>
</tr>
<tr>
<td>Operating system</td>
<td>Windows 2008 R2 SP1 (64-bit)</td>
</tr>
<tr>
<td>Hard disk</td>
<td>500 GB</td>
</tr>
<tr>
<td></td>
<td>• System partition (drive C:): 150 GB</td>
</tr>
<tr>
<td></td>
<td>• Data partition (drive D:): 350 GB</td>
</tr>
</tbody>
</table>

| Process Historian database | 1 TB |

### Example configuration data

The determined performance data are based on the configuration:

<table>
<thead>
<tr>
<th>Objects in the PerformanceMonitor Configuration Studio</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equipments</td>
<td>10</td>
</tr>
<tr>
<td>KPI per Equipment</td>
<td>6</td>
</tr>
<tr>
<td>Operands per KPI</td>
<td>10</td>
</tr>
<tr>
<td>Context information per Equipment</td>
<td>3</td>
</tr>
</tbody>
</table>
Objects in the process picture

<table>
<thead>
<tr>
<th></th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>PerformanceView control</td>
<td>1</td>
</tr>
<tr>
<td>Equipment in the PerfomanceView control</td>
<td>3</td>
</tr>
</tbody>
</table>

Determined performance data with logging cycle of 1 minute

The following surcharge times have been determined in the PerformanceView control based on the hardware configuration and configuration data listed above:

<table>
<thead>
<tr>
<th>Evaluated time period</th>
<th>Without context change</th>
<th>Context change between two values</th>
<th>Context change between four values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 hour</td>
<td>Approx. 1 second</td>
<td>Approx. 1 second</td>
<td>Approx. 1 second</td>
</tr>
<tr>
<td>24 hours</td>
<td>Approx. 1.x seconds</td>
<td>Approx. 3 seconds</td>
<td>Approx. 3.x seconds</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Evaluated time period</th>
<th>Without context change</th>
<th>Context change between two values</th>
<th>Context change between four values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 hour</td>
<td>&lt; 2 seconds</td>
<td>Approx. 2 seconds</td>
<td>Approx. 4 seconds</td>
</tr>
<tr>
<td>24 hours</td>
<td>Approx. 51 seconds</td>
<td>Approx. 111 seconds</td>
<td>Approx. 222 seconds</td>
</tr>
</tbody>
</table>

Restrictions for virtual machines due to performance and capacity limits

This section includes information on the tested performance and capacity limits.

Configuration/Supported limits

The supported limits and configuration of physical machines can be applied. When these supported limits are exceeded, you may experience unexpected results, a significant drop in performance and other negative consequences. Changing the configuration (e.g. multiple hubs, no fixed reservation of work memory) may result in loss of performance and can therefore not be guaranteed.
# 1.3 Licenses

The following table shows the licensing model for the WinCC PerformanceMonitor.

An archive tag corresponds to one of the following objects whose values are saved in the Process Historian component of WinCC:

- Operand
- Status value of a structured operand
- Context information

<table>
<thead>
<tr>
<th>Name on license data storage medium</th>
<th>Number of logging tags</th>
<th>License type</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC PerformanceMonitor Basic</td>
<td>30</td>
<td>Single license</td>
</tr>
<tr>
<td>WinCC PerformanceMonitor Log¹</td>
<td>30 / 100 / 300 / 1000</td>
<td>Count Relevant License</td>
</tr>
<tr>
<td>WinCC PerformanceMonitor Upgrade²</td>
<td>60</td>
<td>Upgrade License</td>
</tr>
<tr>
<td>WinCC PerformanceMonitor Upgrade³</td>
<td>-</td>
<td>Upgrade License</td>
</tr>
<tr>
<td>WinCC PerformanceMonitor Upgrade⁴</td>
<td>-</td>
<td>Upgrade License</td>
</tr>
</tbody>
</table>

¹ In addition to "WinCC PerformanceMonitor" license.
² Allows upgrade of the WinCC DowntimeMonitor 6.2 / 7.0 to WinCC PerformanceMonitor V7.2. Includes a "WinCC PerformanceMonitor" license and a "WinCC PerformanceMonitor Log" license with a total of 60 logging tags. An upgrade to PerformanceMonitor V7.3 must be purchased separately.
³ Authorizes an upgrade of **one** licensed version of the PerformanceMonitor V7.2 to PerformanceMonitor V7.3
⁴ Authorizes an upgrade of **one** licensed version of the PerformanceMonitor V7.3 to PerformanceMonitor V7.4
1.4 Installation basics

PerformanceMonitor components

During installation of the PerformanceMonitor, you can select the following components using the "User-defined installation" option. Only the components "Editor and Service" and "Controls" are installed as part of the "Package installation".

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>PerformanceMonitor server</th>
<th>PerformanceMonitor client</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>PerformanceMonitor server</td>
<td>PerformanceMonitor client</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mandatory</td>
<td>Optional</td>
</tr>
<tr>
<td>Editor and Service</td>
<td>Installs the PerformanceMonitor and the required services.</td>
<td>Yes¹,²</td>
<td>-</td>
</tr>
<tr>
<td>Controls</td>
<td>Installs the following Runtime controls for output of the KPI or operands:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● WinCC PerformanceViewControl</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● WinCC PerformanceGanttControl</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● WinCC PerformanceTableControl</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Controls (plug-in)</td>
<td>Installs the plug-in for the WinCC/WebNavigator server.</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Report (templates)</td>
<td>Installs the report templates for use in the SIMATIC Information Server.</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Process Historian component</td>
<td>Installs the Process Historian component to save the calculated KPIs.</td>
<td>Yes⁴</td>
<td>-</td>
</tr>
<tr>
<td>Information Server Excel Add-Ins 2014</td>
<td>Installs the Excel add-in for output of the calculated KPIs in MS Excel. The SIMATIC Information Server is required as data source. MS Excel 2007 and MS Excel 2010 are supported. Requirement: .NET-Framework 4.5 is installed.</td>
<td>-</td>
<td>Yes</td>
</tr>
</tbody>
</table>

¹ The installation on a client without its own project has not been approved.
² A Runtime license and a WinCC client project is required on a WinCC client with its own project.
³ Required on the WebNavigator client if the PerformanceMonitor controls are not installed. Then install the plug-in from the download area of the Web Navigation interface.
⁴ The installation is not necessary if a central Process Historian is available in the network and the results of the PerformanceMonitor are to be saved on the central Process Historian.
⁵ Can also be installed separately on a standard PC. Standard PC requires access to SIMATIC Information Server and PerformanceMonitor Server.

Report generation with SIMATIC Information Server

The Information Server must be installed in order to generate reports.
You install the required components using the setup of WinCC V7.4.

**Installation sequence**

If you want to use the report generation feature of the Information Server, perform the following installation sequence:

1. WinCC V7.4
2. Information Server 2014 SP2
3. PerformanceMonitor V7.4
4. Configuring the PerformanceMonitor server

**Supplementary installation of the SIMATIC Information Server**

When you install the Information Server after the PerformanceMonitor, perform the following installation sequence:

1. WinCC V7.4
2. PerformanceMonitor V7.4
3. Configuring the PerformanceMonitor server
4. Information Server 2014 SP2
5. Retro-installation of the PerformanceMonitor component, "Report (Templates)"

**See also**

Installing PerformanceMonitor (Page 13)
1.5 Installing PerformanceMonitor

Introduction

The PerformanceMonitor server saves the calculated KPIs in one of two storage locations:

- Local Process Historian component: Installation via PerformanceMonitor setup
- Central Process Historian server: Installation via setup of the Process Historian Server 2014 SP2

When you install a PerformanceMonitor server with local Process Historian component, you need to configure the database in a second step.

The installation of a PerformanceMonitor client is completed after the PerformanceMonitor setup and rebooting the PC.

NOTICE

Restart of PC required after installation

Make sure that a restart does not have a negative impact on the operation of your plant prior to installation.

A restart is required after installation of the PerformanceMonitor. If you are installing the PerformanceMonitor on a WinCC server with process connection, the connection to the process is interrupted by the restart.

Recommendation: Install the PerformanceMonitor on a separate PC without process connection.

Requirement

WinCC V7.4 is installed on the WinCC server.

Procedure

1. Insert the PerformanceMonitor DVD into the DVD drive.
2. Double-click the "Setup.exe" file in the "DVD" folder.
   The setup program is started.
3. Select the required setup language and follow the instructions.
4. Select "User-defined installation" to install a PerformanceMonitor server.
5. Select either "Package installation" or "User-defined installation" to install a PerformanceMonitor client.
6. Confirm your entries.
   The PerformanceMonitor is installed.
7. Restart your PC.
8. You then need to configure your database if you are installing a PerformanceMonitor server with local Process Historian component.
Configuring the database

The configuration of the database is started automatically after installation and restart.

1. Follow the instructions of the installation wizard for the Process Historian database.
2. Select the required instance of the local SQL server in the menu.
3. Select the required memory limit with the slider.
4. Select the "Installation on master server" option.
5. Enter a name for the database.
6. Select "Standard" as installation mode.
7. Enter the required destination paths.
8. Finish the installation with "Finish" and restart your PC.

Result

The PerformanceMonitor is installed. Depending on the installation, the local Process Historian component is also installed.

After the initial start of the PerformanceMonitor, connect to the "Process Historian server". For an installation with local Process Historian component, newly created WinCC projects are automatically connected to the local Process Historian component.

Uninstalling PerformanceMonitor

1. Insert the PerformanceMonitor DVD into the DVD drive.
2. Double-click the "Setup.exe" file in the "DVD" folder.
   The setup program is started.
3. Select the required setup language and follow the instructions.
4. Select "Uninstall".
5. Confirm your entries.
   The PerformanceMonitor is uninstalled.
6. Restart your PC.

See also

Installation basics (Page 11)
2.1 Notes on PerformanceMonitor

Introduction

These release notes contain important information.

The statements in these release notes take precedence over information provided in the manuals and in the online help.

Read these release notes carefully as they contain useful information.

Defense in depth

See the notes on "Industrial Security" on the Siemens website:


Archived values in a local Process Historian component are deleted on re-installation of a wizard

If you uninstall PerformanceMonitor, the local Process Historian component, including the values saved in it, is not deleted. If the PerformanceMonitor is re-installed, the local Process Historian component is re-generated by default. Saved values are deleted in this process.

If you want to retain the archived values, enter another name for the local Process Historian component in the case of a re-installation.

Faulty import after character change

When you change entries in an exported Excel spreadsheet from capital letters to lower-case letters after an import, the new import of the changed table will be faulty.

Documentation for working with time ranges

Contrary to what is stated in the documentation under "Output KPIs > Basics for output of KPIs", the duration with reference point is not calculated starting at any random time in the past.

Use a specific time in the past to calculate the duration with reference point.
Examples for the functions POW and EXP in the formula editor

You can, for example, use the following format for the functions POW and EXP:

- Pow(o1,2)
- Exp(o1)

\(o1\) is the operand in this case.

Changing the runtime language

When you use a PerformanceMonitor control in a process picture in WinCC Runtime and switch the runtime language, the runtime language of the PerformanceMonitor control does not switch automatically.

Remedy:

Change picture after switching the runtime language in WinCC.

When you go back to the process picture with the PerformanceMonitor control, the PerformanceMonitor control is also displayed in the switched runtime language.

See also

2.2 New functionalities

PerformanceMonitor Configuration Studio
The PerformanceMonitor Configuration Studio has been revised and adapted to the WinCC V7.4 standard.

Defining anchor point as tag
You define the anchor point as tag in PerformanceMonitor V7.4 if you want to control it with a CPU.

Import/export
You can export or import the configuration data to a TXT file or XLSX file.

PerformanceGanttControl
In the PerformanceGanttControl, you have the option to display all structured operands in a row.
In the PerformanceViewControl, you have the option to define the level design of the bars and depict an overlapping of the bars.
2.3 Service and Support

2.3.1 Warnings

Safety notes

This manual contains information that must be observed to ensure your personal safety and to prevent property damage. Notices referring to your personal safety are highlighted in the manual by a safety alert symbol; notices referring to property damage only have no safety alert symbol. Depending on the hazard level, warnings are displayed in a descending order as follows:

- **DANGER**: means that there can be severe physical injury or even death if the corresponding safety measures are not followed.

- **WARNING**: means that there can be severe physical injury or even death if the corresponding safety measures are not followed.

- **CAUTION**: indicates that minor personal injury may result if proper precautions are not taken.

- **NOTICE**: indicates that damage to property may result if proper precautions are not taken.

Note

is an important information about the product, the way to handle the product or the respective part of the documentation and we wish to especially bring this to your notice.

If multiple levels of hazards can occur, the warning is always displayed with the highest possible level. If a warning with a warning triangle is to be indicate physical injury, the same warning may also contain information about damage to property.

Qualified Personnel

The corresponding machine/system may only be set up and operated with the help of this documentation. A device/system must only be commissioned and operated by qualified personnel. Qualified persons in the sense of safety instructions in this documentation stand for persons who are authorized to operate, earth and mark machines, system and electrical circuits according to safety standards.
Proper use

Please observe the following:

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proper use</td>
</tr>
<tr>
<td>The machine may only be used for the application instances that have been described in the catalog and the technical description and only in combination with third-party devices and components recommended and/or approved by Siemens. Smooth and safe operations demand proper transport, proper storage, installation and assembling as well as careful operations and maintenance.</td>
</tr>
</tbody>
</table>

Brands

All names identified by ® are registered trademarks of Siemens AG. Third parties using for their own purposes any other names in this document which refer to trademarks might infringe upon the rights of the trademark owners.

Security information

Siemens provides products and solutions with industrial security functions that support the secure operation of plants, solutions, machines, equipment and/or networks. They are important components in a holistic industrial security concept. With this in mind, Siemens’ products and solutions undergo continuous development. Siemens recommends strongly that you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable preventive action (e.g. cell protection concept) and integrate each component into a holistic, state-of-the-art industrial security concept. Third-party products that may be in use should also be considered. For more information about industrial security, visit

- http://www.siemens.com/industrialsecurity

To stay informed about product updates as they occur, sign up for a product-specific newsletter. For more information, visit

- http://support.automation.siemens.com

Disclaimer of liability

We have checked the contents of the description to ensure that it matches with the hardware and the software it describes. Nevertheless, we cannot assume responsibility for any deviations that may arise. The details outlined in this description are checked regularly and the required corrections are done in the subsequent editions. Suggestions for improvement are welcomed.

The statements in the online documentation are more binding than the statements in the manuals and PDF files.

Please follow the Release Notes and Installation Notes. The information in these Release Notes and Installation Notes has priority over that in the manuals and online help with regard to legal validity.
Copyright © Siemens AG 2016

Änderungen vorbehalten / All rights reserved

It is prohibited to transfer, copy, evaluate or communicate this document in full or part unless the same has been explicitly approved. Violation of this rule can lead to claims for damage compensation. All rights reserved, especially for granting patents or for GM registration.

Siemens AG
Digital Factory
SIMATIC Human Machine Interfaces
P.O. Box 4848
D-90026 Nuremberg, Germany

See also

http://support.automation.siemens.com (http://support.automation.siemens.com)

2.3.2 Customer Support

Customer Support and Technical Support

You can reach the SIMATIC hotlines at the times specified in the following table. The SIMATIC hotline employees speak German and English. The Authorization hotline offers French, Italian or Spanish customer support in addition to German and English.

Technical support

Nuremberg (GMT +1:00)
Service Hours Monday - Friday, 8:00 to 17:00 (CET/CEST)
Phone +49 (0)911 895 7222
Fax +49 (0)911 895 7223
E-mail http://www.siemens.com/automation/support-request (http://www.siemens.com/automation/support-request)

An overview of the Technical Support is available at the following URL:

Automation Value Card (AVC)

The Automation Value Card (AVC) provides extended Technical Support and is available 24 hours every day of the week. Information on the AVC can be found at the following URL:


SIMATIC Customer Online Support

Service and Support

An overview of the support offering for our products is available at the following URL:

- http://www.siemens.com/automation/service&support

In Product Support, for example, you will find downloads of firmware updates, service packs and useful utilities.

Online Help is available so that you can successfully use the Support offering. Open the Online Help by selecting the corresponding button on the Internet site or at the following URL:

- http://support.automation.siemens.com/WW/support/html_00/help/Online_Hilfe.htm

WinCC FAQs

WinCC Online Support with information on FAQs (Frequently Asked Questions) may also be found at the following URL:

- http://support.automation.siemens.com/WW/view/de/10805548/133000

Technical Forum

The Technical Forum supports exchange with other SIMATIC users. It is available at the following URL:


Technical documentation for SIMATIC products

You can find a guide to the technical documentation provided for individual SIMATIC products and systems at the following URL:


Contact person database

To contact your local agent, search our contact database at the following URL:

Product Information

SIMATIC WinCC
Go to the following URL for additional information about WinCC products:
• http://www.siemens.com/wincc

SIMATIC Products
Go to the following URL for additional information about SIMATIC products:
• http://www.siemens.com/simatic

See also
Internet: Support Request (http://www.siemens.com/automation/support-request)
Internet: Service and Support (http://www.siemens.com/automation/service&support)
Internet: Support Technical Forum (http://www.siemens.de/automation/csi_en/forum)
Internet: Support Search (http://www.siemens.de/automation/csi_en/km)
Internet: Technical documentation for SIMATIC products (http://www.siemens.com/simatic-tech-doku-portal)
Internet: Information about WinCC (http://www.siemens.com/wincc)
Internet: SIMATIC Products (http://www.siemens.com/simatic)

2.3.3 Support Request

Dear customer

In order to provide you with fast and effective support, please complete the "Support Request" form online on the Internet. Describe the problem in as much detail as possible. We would appreciate if you would provide us with all project data, so that we can reproduce the error situation or shorten the turn-around time.

Before filling out the support request, check whether your configured quantity structure is within the range of tested quantity structures (see topic "Performance Data").
Support Request form

The Support Request form is available at the following URL:

- http://www.siemens.com/automation/support-request

When filling out the report, you will be guided through several steps, which will ask about all required information.

A detailed description of the Support Request can be found at the following URL:


Procedure

1. Open the "Support Request" form using the link on the Internet. Step 1 "Select product" is displayed:

2. Enter the project name in the "Product/Order number" box. Upper/lower case is not relevant. Search for parts of the product name or enter the full product name in the correct order. You can e. g. search for the following terms:
   - "WinCC Runtime"
   - "WinCC DataMonitor"
   - wincc webnavigator
   - "Connectivity"
   The found products are offered in the "Product selection" field.

3. Select the desired product and click on "Next" to switch to step 2 "Select use case".

4. Select a use case or describe your specific use case in the "Other use case" field.

5. Press "Next" to switch to step 3 "Our solutions". Suggested solutions and FAQs for the selected key words are listed. Once you have found a suggested solution for your problem, you can close the form in the browser. If you did not find any applicable suggested solutions, press "Next" to switch to step 4 "Describe problem".

6. Describe your problem as exactly as possible in the "Details" field. Pay particular attention to the following questions and comments. Please also check the WinCC installation and configuration with regard to the following references. If you have any idea what has caused the error, please let us know. No detail should be omitted, even if you consider it unimportant.
   - Was the configuration data created with older WinCC versions?
   - How can the error be reproduced?
   - Are other programs running simultaneously with WinCC?
   - Have you deactivated the screen saver, virus checker and power management function?
   - Search the computer for log files (WinCC\Diagnose\*.log, drwatson.log, dwtsn32.log). The log files are needed for error analysis. Thus, be sure to send the log files as well.

7. Use the "Search" button to upload your affected project and the log files (e. g. as a Zip file) to the Support Request. Press "Next" to switch to step 5 "Provide contact information".
8. Enter your contact information.
   Read the privacy notice and choose whether your personal data should be permanently saved.
   Press "Next" to switch to step 6 "Summary & Send".

9. Press the "Print" button if you would like to print the support request.
   You close the support request by clicking the "Send" button.
   Your data will be transmitted to Customer Support and processed there.

Thank you for your cooperation. We hope that we can be of assistance in solving your problems.
Your WinCC Team

See also

Internet: Error Report (http://www.siemens.com/automation/support-request)
3.1 Basics

3.1.1 Basics about the PerformanceMonitor

Motivation

Up to now, you have calculated the relevant characteristics for controlling your plant outside WinCC and displayed them graphically in supplemental tools, such as Excel.

You can use the PerformanceMonitor to identify deviations and optimization potential earlier. In this way, you can cut costs and reduce downtimes.

Use

Using the WinCC PerformanceMonitor option, you can integrate the calculations and representations of key performance indicators (KPIs) in WinCC.

The PerformanceMonitor provides support for plant controlling and helps you to substantiate decisions with KPIs:

- Management and quality assurance
  Complete transparency for all machines as basis for optimizing plant productivity.

- Servicing and maintenance
  Support through calculation of characteristics, cyclically and triggered by process events.

- Line management and plant operator
  The operator is always kept up-to-date by graphical display of the characteristics.

The PerformanceMonitor uses the tools and user interfaces you know from WinCC. Use of the existing infrastructure reduces the administration and configuration overhead.

How it works

The PerformanceMonitor calculates the KPIs based on the process values available in WinCC. To visualize the evaluations, you can use the available WinCC configuration options, for example, the Graphics Designer.

The following figure shows the visualization of data from the plant. Key performance indicators are later calculated from this data and displayed graphically:
The plant section is represented as "Equipment" in the PerformanceMonitor Configuration Studio. KPIs are calculated for the equipment.

WinCC tags which are connected to operands in the PerformanceMonitor Configuration Studio. An operand is an input parameter of KPIs.

Additional context information, e.g. Supplier or product identifier (ProductID). The context information is important for the subsequent evaluation of the calculated KPIs.

The operands associated with the WinCC tags are stored in the archive. The number of operands and the amount of context information stored depends on the licensing.

You can use these operands to calculate the KPIs for a period of time specified at the time of evaluation.

You can also evaluate the calculated KPIs in Runtime and/or in WinCC reports or in Information Server reports in graphical or tabular form.

See also

PerformanceMonitor Configuration Studio (Page 35)

WinCC/PerformanceMonitor - Getting Started (http://support.automation.siemens.com/WW/view/en/82523701/133300)
3.1.2 Use in the WinCC environment

Overview

The figure below shows the use of the PerformanceMonitor in the WinCC environment:

<table>
<thead>
<tr>
<th>WinCC Tag Management</th>
<th>Connect operands to WinCC tags (read values)</th>
</tr>
</thead>
<tbody>
<tr>
<td>WinCC Performance-Monitor</td>
<td>PerformanceMonitor Configuration Studio for configuring KPIs, equipment, operands, structured operands, etc.</td>
</tr>
<tr>
<td></td>
<td>Runtime controls for evaluating and displaying the calculated KPIs. Configuration in the Graphics Designer.</td>
</tr>
<tr>
<td>Graphics Runtime</td>
<td>Information Server</td>
</tr>
<tr>
<td></td>
<td>Operands store the recorded values in the Process Historian component</td>
</tr>
<tr>
<td></td>
<td>The KPIs are calculated and shown in tabular/graphical form for a specific query by a control.</td>
</tr>
</tbody>
</table>

Configuration examples

The PC needs to be restarted after installation of the PerformanceMonitor. The following is recommended for integration of the PerformanceMonitor into an existing infrastructure:

- Provide an additional server for the PerformanceMonitor.
- You can also install the PerformanceMonitor on a PC without process connection.

All of the following configuration examples also show the use of the Information Server and the WebNavigator server.

Single station system

The figure below shows the use of the PerformanceMonitor in a single-user system. The single-user solution is only suitable for small scale projects. The optional packages Information Server and WebNavigator server place an additional load on performance:
Client/server system: Access via WinCC clients

The figure below shows the integration of the PerformanceMonitor into an existing client/server system. WinCC/Server is installed in addition on the PC with the PerformanceMonitor. You can use it to access the functions of the PerformanceMonitor from all WinCC clients in Runtime.

Note

Archiving data of a single-user installation (local archiving) into another single-user installation (local archiving) is not allowed.
Client/server system: Using WinCC/Config RT 128 TAG

The figure below shows the integration of the PerformanceMonitor into an existing client/server system. WinCC/Config-RT 128 TAG is installed in addition on the PC with the PerformanceMonitor. Access to the functions of the PerformanceMonitor in Runtime is therefore limited to this PC.

3.1.3 Objects in the PerformanceMonitor

Overview

To calculate and display KPIs and the associated information, the PerformanceMonitor uses the following objects:

<table>
<thead>
<tr>
<th>Object</th>
<th>Definition</th>
<th>Use/evaluation in WinCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equipment</td>
<td>Represents a freely-definable plant or plant unit.</td>
<td>You assign to each piece of equipment the desired KPIs that are calculated for the equipment.</td>
</tr>
<tr>
<td>KPI (“Key Performance Indicator”)</td>
<td>A key performance indicator is calculated as required for a defined time period.</td>
<td>You define the KPI from one or more operands and KPIs - independent of the equipment.</td>
</tr>
<tr>
<td>Operand</td>
<td>Saves a value with a time stamp in the Process Historian component.</td>
<td>Obtains its value from a WinCC tag or a formula.</td>
</tr>
<tr>
<td>Structured operand</td>
<td>Saves a state with a time stamp in the Process Historian component.</td>
<td>Contains a list of states that are assigned values or value ranges. You can evaluate the states in calculations.</td>
</tr>
</tbody>
</table>
### 3.1 Basics

<table>
<thead>
<tr>
<th>Object</th>
<th>Definition</th>
<th>Use/evaluation in WinCC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operand formula</td>
<td>Calculates a value from process values. The result is returned to an operand.</td>
<td>Required for calculation of a value which is not provided by the controller, for example.</td>
</tr>
<tr>
<td>Context information</td>
<td>Defines criteria that describe a piece of equipment in more detail, for example:</td>
<td>Required for detailed evaluation in a report or plant picture. Not required for pure calculation of KPIs.</td>
</tr>
<tr>
<td></td>
<td>● Manufacturer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Product</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Batch</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Operator</td>
<td></td>
</tr>
</tbody>
</table>

### See also

PerformanceMonitor Configuration Studio (Page 35)

### 3.1.4 Type and instance concept

**Introduction**

The PerformanceMonitor uses a type and instance concept.

**Types**

You create operands, operand formulas, structured operands, KPIs, and context information as types with unique names:

- You define the calculation formula for KPIs.
- You define the calculation formula and the evaluation type for operand formulas.
- You define the evaluation type for operands.
- You define the available entries for structured operands and context information.
Example: To determine the quality of products produced in three production lines of a factory building, set only the KPI "QualityRate" as well as the two operands "GoodItemsProduced" and "TotalItemsProduced". Then you define the KPI: "QualityRate = (GoodItemsProduced / TotalItemsProduced)*100".

Instances

Once you have mapped your plant in PerformanceMonitor with equipment, you assign the KPI types to the equipment. One instance of each object is generated for this. At each place of use, you configure the object instances and assign values, tags or operand formulas to them.

Example: At each place of use of the KPI "QualityRate", you assign the corresponding WinCC tags to the operand instances "GoodItemsProduced" and "TotalItemsProduced".
The pieces of equipment defined are listed in tree form under "Instances".

The KPI types already assigned to this equipment are displayed as instances in the working area. The operands calculated in the KPIs are automatically added as operand instances.

Subsequent modification of types

Changes made to types affect all object instances: If, for example, you change the name or color of a type, all instances are updated automatically. The parameter assignment is retained.

If you change the calculation formula of a KPI type, you must re-configure the newly added operands at the instance. Deleted operands in the calculation formula are automatically removed from the instance.

3.1.5 Output options for KPIs in Runtime

You can output the operands and KPIs as follows:

- In WinCC Runtime using Runtime controls
- In WinCC Runtime using the "Print" button
- In the SIMATIC Information Server
- In WinCC/WebNavigator

See also

Controls for displaying the KPIs (Page 100)
Creating a PerformanceMonitor report in the Information Server (Page 128)
3.2 Elements and basic settings

3.2.1 PerformanceMonitor Configuration Studio

Function
The PerformanceMonitor Configuration Studio is the user interface of the PerformanceMonitor. You enter all the information used to calculate the desired KPIs for your plant in this interface.

Opening PerformanceMonitor
When you open a WinCC project after installing the PerformanceMonitor, the PerformanceMonitor icon appears in the navigation area of the WinCC Explorer. Double-click the PerformanceMonitor icon.
The PerformanceMonitor Configuration Studio consists of the following areas:

1. **Menu bar:**
   The menu bar contains commands to perform common functions in the PerformanceMonitor Configuration Studio.

2. **Operands:**
   - **Name:** numberofAssets
   - **Evaluation Type:** Number

3. **Properties:**
   - **Selection:**
     - **Object type:** Operands
     - **Object name:** numberofAssets
   - **General:**
     - **Name:** numberofAssets
     - **Evaluation Type:** Number

4. **Colors:**
   - **Bar Color:** #255, 255, 255
   - **Text Color:** #0, 0, 0
2 Navigation area:
The navigation area displays the objects of the PerformanceMonitor in a tree view.

- **Equipment configuration**
  You define the plant units to be analyzed under "Equipment configuration". You can combine individual components or machines to a group (plant line). An equipment group is used for structuring during configuration. The grouping has no effect in Runtime. You can assign a KPI to this piece of equipment (component or machine) once directly. The KPI is still available for other equipment.

- **Types**
  You define the following object types under "Types":
  - KPIs
  - Operands
  - Structured operands
  - Operand formulas
  - Context information

- **Instances**
  You assign KPIs and context information to a piece of equipment and assign parameters to the object instance under "Instances".

3 Table area:
The table area displays the data records of the objects that are selected in the navigation area. In quick search, you search the table area for entries.

4 "Properties" window:
The "Properties" window displays the properties of a data record.

5 Navigation bar:
In the navigation bar, you switch between the WinCC editors.

6 Status bar:
The status bar shows the various states of the PerformanceMonitor Configuration Studio.

### Menu commands in the menu bar

The menu bar contains some of the commands that you can call in the PerformanceMonitor Configuration Studio. Commands that you cannot use in the current situation are disabled (displayed in gray). Commands that you can call from the shortcut menu are described in the individual sections in which they are used.

The following tables show the commands in the menu bar and their functions:

#### "File" menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves all settings in the PerformanceMonitor Configuration Studio.</td>
</tr>
<tr>
<td>Project Documentation - Setup</td>
<td>No function.</td>
</tr>
<tr>
<td>Project Documentation - Preview</td>
<td>No function.</td>
</tr>
<tr>
<td>Project Documentation - Print</td>
<td>No function.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the PerformanceMonitor Configuration Studio.</td>
</tr>
</tbody>
</table>
### "Edit" menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies the selected column content.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the copied column content.</td>
</tr>
<tr>
<td>Undo</td>
<td>No function.</td>
</tr>
<tr>
<td>Redo</td>
<td>No function.</td>
</tr>
<tr>
<td>Import</td>
<td>Imports data from a TXT file, XML file or XLSX file.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports the column content to a TXT file or XLSX file.</td>
</tr>
</tbody>
</table>

### "View" menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input language</td>
<td>Changes the input language.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>Changes the color setting in the PerformanceMonitor Configuration Studio.</td>
</tr>
</tbody>
</table>

### "Tools" menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macros</td>
<td>Opens a dialog box in which you can create macros.</td>
</tr>
<tr>
<td>Visual Basic Editor</td>
<td>Opens the Visual Basic Editor.</td>
</tr>
</tbody>
</table>

### "Templates" menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicators</td>
<td>Pre-defined KPIs are created to which you can assign parameters.</td>
</tr>
<tr>
<td>Structured operands</td>
<td>A pre-defined structured operand is created and configured according to the OMAC standard. The parameter assignment can be changed.</td>
</tr>
</tbody>
</table>

### "Help" menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents and Index</td>
<td>Opens the online help of the PerformanceMonitor.</td>
</tr>
<tr>
<td>Info about WinCC Configuration Studio</td>
<td>Opens an information window for the WinCC Configuration Studio.</td>
</tr>
</tbody>
</table>

### Reporting of user actions

User actions, such as the import of configuration data, are saved in the log file. The log file is stored in the following directory:

- C:\ProgramData\Siemens\Logs\PerformanceMonitor
The log file is created on configuration changes, import/export or when starting Runtime.

**See also**

Exporting and importing configuration data (Page 88)

### 3.2.2 Managing the PerformanceMonitor Configuration Studio

**Changing the interface language**

The interface language of the PerformanceMonitor Configuration Studio depends on the WinCC user interface language.

To change the interface language, select your desired language in the WinCC Explorer in the "Tools > Language..." menu bar.

**Changing text input mode**

With text input mode, you define the reaction that occurs when changing display texts.

When a text is entered, a check is performed to determine whether the text already exists in the Text Library. If the text is already present, the "Text Input Mode" window opens.

1. Select the "View > Change Text Input Mode" command.
2. Activate the desired text input mode.

The following texts of object properties from the PerformanceMonitor are stored in the text library:

- Display name
- Comment
- Tooltip

**Switching the sorting order in columns**

By default, the sorting order in columns corresponds to the order in which you created the objects. To change the sorting order, double-click on the title bar of the relevant column.

Each double-click switches the sorting order as follows:

- Alphabetically from A to Z
- Alphabetically from Z to A
- Without sorting (initial state)

**Showing and hiding columns**

You can show and hide individual columns. The configuration data of hidden columns is retained.
Showing columns
To hide a displayed column, select the "Hide" command in the shortcut menu of the column header.

Hiding columns
To display a hidden column, select the "Unhide > [column header]" command in the shortcut menu of the column header.

The following columns are hidden by default:
- Comments
- Bar color
- Text color
- Tooltip

Edit and save entries
The PerformanceMonitor Configuration Studio supports functions such as "Search and Replace" and "Copy and Paste" - also to and from MS Excel. Object names are automatically incremented when they are pasted.

To save the configuration data, select the entry "Save" in the menu bar under "File".

See also
Exporting and importing configuration data (Page 88)

3.2.3 Formula editor
Function
In the formula editor, you enter a formula, the result of which is returned to a KPI or operand. The result of a formula is either a logical value (BOOLEAN) or a number. To immediately check a formula for plausibility during its entry, use only logical or arithmetic operators.

You use the formula editor for the following objects in the PerformanceMonitor:
- KPIs
- Operand formulas
Opening the formula editor

1. In the navigation area of the PerformanceMonitor, select the "Key Performance Indicators" or "Operand formulas" object under "Types".

2. In the table area, select the row of the "Calculation Statement" column in which you want to use the formula editor.
   Alternatively, select any row in the line in which you want to use the formula editor, and select the column next to the "Calculation formula" entry in the "Properties" window.

3. Click the button "...".
   The formula editor opens.

Structure

The formula editor consists of the following areas:

1. Details view:
   Your configured KPIs and operands are listed in the detail view. Drag-and-drop the required KPIs and operands from the Details view into the formula editor.
   The quick search enables you to search the Details view for entries.

2. Formula Editor:
   The formula editor supports Intellisense as you type.
Rules for using operators

If you only use logical operators in a formula, all values are interpreted as Boolean:

- Value $\neq 0 \rightarrow TRUE$
- Value $= 0 \rightarrow FALSE$

If you only use arithmetic operators in a formula, all values are interpreted as arithmetic:

- FALSE = 0
- TRUE = 1

If you use typecast commands, make sure you convert the values correctly. The following typecast commands are supported:

- ToInt
- ToBool
- ToFloat
3.3 Working with the PerformanceMonitor

3.3.1 Procedures for the KPI definition

Possible procedures
You are not bound to a fixed workflow for defining and evaluating the KPIs for your plant. The work steps can also be allocated to multiple persons, e.g. a manager and a configuration engineer:

- The manager defines the equipment, KPIs, operands and the calculation.
- The configuration engineer assigns the KPIs to the equipment and interconnects the operands with WinCC tags.

Notes on structuring the plant
The PerformanceMonitor calculates the KPIs and checks the evaluations but not the plausibility. The user is responsible for ensuring that the KPI definition is feasible and for linking the relevant parameters/process values.

3.3.2 Configuration support

Introduction
Objects in the PerformanceMonitor Configuration Studio have the following relationships:

- Operand types belong to KPI types
- Context information belongs to equipment
- Calculation formulas belong to KPIs types
- Operand formulas are used at operand instances
- KPI types and context information are used in equipment

Suggestions for configuration sequences

Object types:
1. Configure operand types
2. Configure operand formulas (optional)
3. Configure KPI types
   - Define the calculation formula
   - Define the calculation cycles (optional)
4. Configure context information types
5. Configure equipment

Object instances:
1. Assign KPI types to the equipment
2. Assign parameters to context information instances
3. Assign parameters to operand instances
   - Connect WinCC tags
   - Assign parameters to the calculation type
4. Assign parameters to the cyclic calculation of KPI instances (optional)

Templates

In PerformanceMonitor, you can find the "DownTimeMonitor" template in the menu bar under "Templates > Indicators". This template automatically generates typical KPIs that you can configure.

OMAC templates

If you want to configure according to the OMAC standard, you can use the OMAC templates. You can find the OMAC templates in the menu bar of the PerformanceMonitor under "Templates > Structured Operands". The following templates are at your disposal:

<table>
<thead>
<tr>
<th>Templates</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMAC_V3_Gruppierung</td>
<td>A structured operand called &quot;OMW&quot; is automatically created and configured. The parameter assignment can be changed.</td>
</tr>
<tr>
<td>OMAC_V3_Detail</td>
<td>A structured operand called &quot;OMWDetailed&quot; is automatically created and configured. The parameter assignment can be changed. More detailed template as &quot;OMAC_V3_Gruppierung&quot;.</td>
</tr>
</tbody>
</table>

Incomplete configurations

Incomplete configurations are highlighted in color in the PerformanceMonitor Configuration Studio. The figure below shows KPI types with calculation formula in which one or more operand types are not yet configured:
The incorrect results are collected in a list. You directly access the location of the error by clicking the entry.

Validity check

The PerformanceMonitor always checks your entries for validity. If an operand is no longer valid due to changes, for example, or when instance assignment problems occur, the messages are visible in the validation result. You can find the "validation result" in the navigation bar of the PerformanceMonitor.

Notes on calculating KPIs

The time it takes to calculate KPIs mainly depends on the following factors:

- Time period
- Number of recorded values
- Number of KPIs to be calculated

The following is recommended for the calculation of KPIs:

- Use values in the range of seconds or higher as the update cycle.
- Calculate KPIs for a time period of up to one day on a WinCC client, for example, evaluations at the end of a shift.
- Calculate longer time periods on PCs without a process connection, for example, evaluations over weeks or months.

3.3.3 Connecting PerformanceMonitor with the Process Historian server

Introduction

Depending on the configuration, the PerformanceMonitor saves the calculated KPIs in one of two storage locations:

- Local Process Historian component: Installation via PerformanceMonitor setup
- Central Process Historian server: Installation via setup of the Process Historian Server 2014 SP2

After installation of the PerformanceMonitor, you have to connect to an available Process Historian. You can change the connection at any time.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Delayed start of Runtime</strong></td>
</tr>
<tr>
<td>When the Process Historian storage location is not configured correctly, activation of Runtime is delayed for up to 10 minutes when starting the PIService.ITagCalculatorCS. When using controls in Runtime, messages are displayed that point out an incorrect configuration.</td>
</tr>
</tbody>
</table>
Note

Data migration
The migration of data from the local Process Historian component to a central Process Historian and vice versa is not supported. Changeover is nevertheless possible at any time.

Requirement

- PerformanceMonitor is started
- Connect with central Process Historian:
  - A user with the same name is created on both PCs in the Windows user management.
  - User is member of the "Administrators" group or has administrator rights
  - User or "Administrators" group is member of the local safety directive "Log on as a service".
  - User is created on the central Process Historian in "MS SQL Server Management" under "Security > Logins" and has the "public" and "sysadmin" rights.
  - Central Process Historian is available
- Connect with local Process Historian component:
  - Local Process Historian component is installed.
Procedure

**Automatic listing of the Process Historian storage location**

1. In the navigation area of the PerformanceMonitor, select “Process Historian storage location > Automatic”.
2. Select “Start search” in the shortcut menu.
   The PCs with a Process Historian installation are listed.
3. In the table area, select the complete line of the PC to which you want to connect.
4. Select “Apply” in the shortcut menu.

**Manual input of the Process Historian storage location**

1. In the navigation area of the PerformanceMonitor, select “Process Historian storage location > Manual”.
2. In the table area, enter the PC name on which a Prozess Historian is installed.
   The “Data source” column is filled automatically after correct input of the PC name.
3. In the table area, select the complete line of the PC to which you want to connect.
4. Select “Apply” in the shortcut menu.

---

**Note**

**Possible loss of PerformanceMonitor data when archiving on central Process Historian**

Data is lost in the following cases:

- The central Process Historian is shut down. While the central Process Historian is being shut down, re-start the operator station on which the PerformanceMonitor is running. The data of the central Process Historian in the period between the shutdown and restart of the operator station is **irretrievably** lost.
  
  Example: The central Process Historian is shut down on October 1, 2014 at 12 noon, and restarts on October 2, 2014 at 12 noon. You restart the operator station on 2 October 2014 at 10 am. The data between 1 October 2014 12:00:00 h and 2 October 2014 10:00:00 h is lost.

- 90% or more of the hard disk space of the central Process Historian is occupied. The central Process Historian is automatically deactivated. The data from the queue is lost when the central Process Historian restarts.

**Remedy:** If the central Process Historian is not available, make sure to avoid restarting the operator station on which the PerformanceMonitor is running.

---

**Result**

The PerformanceMonitor is connected with the selected Process Historian. As soon as you activate the project, the calculated KPIs are saved in the Process Historian.

---

**Logon with different system account**

If you are connected to the Process Historian, you are logged on with your system account by default.
To log on with a different system account, follow these steps:

1. In the navigation area of the PerformanceMonitor, select "Process Historian storage location > Logon".
2. Clear the check box in the column "LocalHost".
3. Enter the account with which you want to log on in the "Account" column.
4. You change your password by clicking the "..." button in the "Password" column.

### 3.3.4 Central Process Historian

The SIMATIC Process Historian is the central, high-performance archiving system for the SIMATIC WinCC SCADA system and the PCS 7 process control system. The Process Historian uses Microsoft SQL Server.

You can save and archive all calculated KPIs and operands on a central server in real-time. The data can belong to different PCS 7 or WinCC projects.

This section provides you with an overview of the general functionalities of the Process Historian.

**Note**

You can find detailed information about the SIMATIC Process Historian in the "Process Historian - Administration" online help.

### 3.3.4.1 Management Console - Overview

**Introduction**

The Management Console includes several dashboards that are available for configuration of the Process Historian and for information or diagnostics of the system. The Management Console is installed with the installation of the Process Historian and started automatically at logon. For a manual start, open the Management Console with C:\Program Files (x86)\Siemens \ProcessHistorian\bin\ProcessHistorian.msc.

**Note**

**Certificate verification by Internet Explorer**

In Internet Explorer under "Internet Options > Advanced > Security", deactivate the option "Check for publisher's certificate revocation".

If this option is activated, it can slow down opening of the Process Historian and cause error messages.
## Dashboards - Overview

The following table shows the dashboards of the Management Console and their tasks:

<table>
<thead>
<tr>
<th>Dashboard</th>
<th>Tasks</th>
</tr>
</thead>
</table>
| Process Historian Management      | • Display of basic information about hardware and performance of PC and operating system  
                                    | • Display of status and current activity of the Process Historian server  
                                    | • Display of the license status  
                                    | • Redundancy status  
                                    | • Changing the operating state |
| Plant structure                   | • Display of incorporated projects  
                                    | • Display of the OS server systems  
                                    | • Display of the PC name |
| Data sources                      | • Display for each individual data source of when configuration data and runtime data was last transferred to the Process Historian  
                                    | • Deletion of the configuration data of the projects  
                                    | • Setting a lock to prevent deletion of configuration data |
| I/O systems                       | • Display of the available input and output devices  
                                    | • Display of the memory space used  
                                    | • Detailed information about the load |
| Diagnostics                       | • Diagnostic messages of the Process Historian  
                                    | • Messages from the event display of the operating system |
| Backup/Restore                    | • Display of the archive segments  
                                    | • Creating segment backups  
                                    | • Restoring backed-up segments  
                                    | • Removing segments |
| Compression                       | • Display of the compression state  
                                    | • Configuration of the number of uncompressed archive segments |
| Segmentation                      | • Display of the current segmentation setting  
                                    | • Changing the segmentation settings |
| Database backup                   | • Manual creation of full database backups  
                                    | • Automatic, continuous creation of full database backups |
| Redundancy (is not supported by the Process Historian component) | • Display of the redundancy status  
                                    | • Switchover / disconnection of principal (master) and mirror (standby)  
                                    | • Redundancy configuration |
| Licensing                         | • Display of the current license status of server and project |
| SIMATIC Batch Backup/Restore      | • Display of the selected batch data  
                                    | • Create backups of batch data  
                                    | • Restoring backed-up batch data |
### 3.3.4.2 Operating states of the Process Historian

#### Overview of operating states

The following table provides an overview of the operating states of the Process Historian database and the color code of the associated icons in the status bar:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Process Historian operating state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Active" /></td>
<td><strong>Active</strong></td>
<td>In the &quot;Active&quot; operating state, the Process Historian archives data. You can request data from the OS Server or the Information Server.</td>
</tr>
<tr>
<td><img src="image" alt="ActiveRecovery" /></td>
<td><strong>ActiveRecovery</strong></td>
<td>In the &quot;ActiveRecovery&quot; operating state, the Process Historian requests data from an OS Server for a recognized period without archiving the data. The preceding and subsequent operating state is &quot;Active&quot;.</td>
</tr>
<tr>
<td><img src="image" alt="ActiveRecoveryStarting" /></td>
<td><strong>ActiveRecoveryStarting</strong></td>
<td>This operating state starts &quot;ActiveRecovery&quot;.</td>
</tr>
<tr>
<td><img src="image" alt="ActiveRecoveryStopping" /></td>
<td><strong>ActiveRecoveryStopping</strong></td>
<td>This operating state terminates &quot;ActiveRecovery&quot; and is the intermediate state between &quot;ActiveRecovery&quot; and &quot;Active&quot;.</td>
</tr>
<tr>
<td><img src="image" alt="Disabled" /></td>
<td><strong>Disabled</strong></td>
<td>The Process Historian changes to the &quot;Disabled&quot; operating state in the case of maintenance tasks where access to the database is limited. The maintenance tasks can include the creation or the backup/recovery of segments. The system is offline in this operating state. Access via the network is not possible.</td>
</tr>
<tr>
<td><img src="image" alt="Locked" /></td>
<td><strong>Locked</strong></td>
<td>The Process Historian server is in &quot;Locked&quot; operating state, for example, because the hard disk space has reached its capacity limit. In this operating state, the Process Historian server can no longer be switched to &quot;Active&quot;. No more values are archived. Read access to stored values is possible.</td>
</tr>
<tr>
<td><img src="image" alt="Disabling" /></td>
<td><strong>Disabling</strong></td>
<td>&quot;Disabling&quot; is the intermediate state between &quot;Active&quot; and &quot;Disabled&quot;.</td>
</tr>
<tr>
<td><img src="image" alt="Error" /></td>
<td><strong>Error</strong></td>
<td>The &quot;Error&quot; operating state occurs when an error has been detected or when there is no connection to the SIMATIC Process Historian Server service.</td>
</tr>
<tr>
<td><img src="image" alt="Inactive" /></td>
<td><strong>Inactive</strong></td>
<td>No data is archived in the &quot;Inactive&quot; operating state. In this operating state, you can carry out updates, maintenance work to the Process Historian PC or a restart of the PC.</td>
</tr>
<tr>
<td><img src="image" alt="Shut down" /></td>
<td><strong>Shut down</strong></td>
<td>The intermediate state between &quot;Active&quot; and &quot;Inactive&quot;.</td>
</tr>
<tr>
<td><img src="image" alt="Starting" /></td>
<td><strong>Starting</strong></td>
<td>The intermediate state between &quot;Inactive&quot; and &quot;Active&quot;.</td>
</tr>
</tbody>
</table>
Commands

You can give the Process Historian the following commands by using the shortcut menu of the icon in the status bar:

- Start
- Shut down
- Start recovery

NOTICE

Disable the Process Historian server before shutting down

You must disable the Process Historian server before shutting down the computer on which the Process Historian server is running. There are two options available to you:

- In the start screen of the Process Historian Management Console, select the "Shut down" status.
- In the shortcut menu of the status bar of the Process Historian, select the "Shut down" command.

The "Inactive" status is displayed.

"Locked" operating state of the Process Historian server

If insufficient disk space is available on a monitored drive, the maintenance service sets the Process Historian server to the "Locked" operating state.

In this operating state, the Process Historian server can no longer be set to "Active". The maintenance service can set the Process Historian server to "Active" again only when free space has been increased.

NOTICE

Avoiding the "Locked" operating state

To ensure enough free space is available for the operation of the Process Historian, regularly check the currently available space in the "I/O systems" dashboard.

Determine which automatic mechanisms for reducing the used space can be activated in the dashboards.
3.3.4.3 Central overview of the Process Historian Server

Overview

The "Process Historian Management" dashboard provides an overview of the basic information about the Process Historian. Configuration and diagnostics information of the Process Historian are displayed together here.

The following information is displayed on the "Process Historian Management" dashboard:

- Monitoring the PC:
  - Processor load (CPU)
  - Available RAM
  - Hard disk load (Disk I/O)

- Process Historian:
  - Number of connected data sources
  - Stored tags per second
  - Stored messages per second

- Operating state of Process Historian server: Here you can change the operating mode:
  - Start
  - Shut down
  - Start recovery

- Redundancy status of Process Historian: Here you can update the status
3.3.4.4 Configuring segments

Introduction

The "Segmentation" dashboard provides an overview of the current configuration of the segmentation.

The following default settings are used for segmentation when setting up the Process Historian:

<table>
<thead>
<tr>
<th>Segment time range</th>
<th>One week</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total number of Runtime segments</td>
<td>Five</td>
</tr>
<tr>
<td>Number of future segments</td>
<td>One</td>
</tr>
</tbody>
</table>
The runtime segments include the following segments that are color-coded:

- A segment in green receives the data with the current time stamp.
- Future segments in blue are already reserved for future data.
- Segments in gray for process data with an older time stamp.

**Configuration of the segmentation**

You configure the segmentation of the Process Historian archives in the "Settings" area.

1. Segmentation anchor point:
   - Hour
   - Date
2. Time period for segments:
   - Unit (period)
   - Factor
3. Number of segments:
   - Number of future segments
   - Total number of Runtime segments
Depending on the configuration limits, the amount of data on the hard disk per segment can be very large. This is especially true for uncompressed Runtime segments. When the segments are created, the estimated required memory space is calculated taking into account the size of the previous segments and reserved for future segments.

The segments for historical data generated by the migration are initially created with minimal size. When data is imported, the segments are automatically enlarged by the SQL server.

The optimum settings for the segmentation are a compromise between the occupied memory space and the number of uncompressed data segments to be reserved.

---

**Note**

The Process Historian database is switched automatically to the "Disabled" operating state to allow changes to the segmentation to be carried out. After the settings have been accepted, the database changes back to the "Active" operating state automatically.

---

**Result**

The segmentation of the Process Historian database is configured.

The time range of the archived data that is available as read-only depends on the number of Runtime segments plus the number of archive segments that are not set offline.

---

### 3.3.4.5 Compressing segments

**Introduction**

Internal compression of the archive segments includes the tables of the archive tags and reduces the memory requirements of the Process Historian server. Uncompressed segments have the advantage of delivering data faster when archived data is accessed.

On the "Compression" dashboard, you can see the current compression state as well as the number of uncompressed segments. The default setting is "0" uncompressed segments. Compression then begins with the first archive segment.

The reduction in memory requirements through compression depends on the saved values. For example, if a value does not change over an extended period of time, the compression factor is high. If a value changes constantly, the compression ratio is lower. A compression factor of "5" is a conservative assumption.

---

**Note**

The archive segments are compressed automatically in the background.
Procedure

1. Select the "Compression" dashboard in the navigation of the management console.

![Compression Dashboard](image)

2. Select the "Activate" option in the 'Configuration' area for 'Post compression'.

3. Specify the number of uncompressed segments you want to keep in the "Configuration" area.

4. Click "Apply".

5. The "Current status" area indicates whether compression is enabled and, if so, as of which segment.

Note

The memory requirements may increase when you make changes to the default setting.

Result

The settings for the compression of archive segments have been reconfigured.

3.3.4.6 Backup of segments

Introduction

The storage space of the Process Historian is continuously filled with data. If the free space falls below a limit value, the Process Historian is set to the "Locked" operating state and archiving is stopped.

To ensure that you have enough free space available again in time, you can:

- Back up the segments manually or automatically
- Set the backed-up segments "Offline" or swap them out, thereby removing them from the Process Historian

The backed-up data is initially available in the backup file as well as in the Process Historian database. The segment data is only removed from the database, thus freeing up hard disk memory on the database drives, when the segment is set "Offline" or the respective option is enabled in automatic scheduling.
You can also specify for automatic backup planning a number of delayed segments that are set "Offline" at a later time. The existing data of the delayed segments therefore remains available "Online" longer.

**Overview**

All archive segments of the Process Historian are displayed in the "Backup/Restore" dashboard:

- Segments with the status "Online" can be backed up manually or automatically
- Segments already backed up with the "Offline" status can be restored. You can find additional information on this in Restoring segments (Page 59).

When an archive segment is backed up, the Runtime data is stored in the backup file. The stored data includes:

- Process values
- Messages
Configuration data on the process values and messages
Aggregation data

Note
No access to the database when executing the following functions in the segments:
- During the preparation of a segment
- During the backup of a segment
- During the restoration of a segment
- When the segment is set offline

Requirement
- The segment to be backed up has the "Archive" status.
- When compression is enabled for the archive segments, the archive segments must be completely compressed prior to the backup.

Backing up segments manually
1. Select segment to be backed up in the "Archive segments" area.
2. Click the "Backup" button to launch backup.
3. Select the backup path for the backup file in the "Backup segment" dialog box that opens.
4. Click "Backup".
Backing up segments automatically and setting them "Offline"

1. Click the "Settings" button in the "Archive segments" area.

2. Select the backup path for the backup file in the "Backup segment" dialog box that opens. You can specify further identifiers and descriptions for the backup such as the name or number of the data medium.

![Backup scheduler settings](image)

3. To set segments offline automatically after the backup, select the "Set segment offline after backup" option.

4. Set the number of delayed segments that are to remain available "Online". This extends the period during which you have read access to the archived data.

5. You can enable automatic backup by selecting the "Scheduler is active" option.

6. Click "Confirm".

3.3.4.7 Restoring segments

If you want to access data that is stored in an archived and already swapped out segment, you must restore the segment. When restoring segments, you must select the backup file that matches the segment.

Requirement

- The matching backup files for the segments to be restored exist.
- The Process Historian is in the "Active" operating state.
3.3 Working with the PerformanceMonitor

Procedure

1. Select the "Backup/Restore" dashboard in the navigation of the Management Console.
2. Select the segment you want to restore in the "Restore segments" area.
3. Click on the "Restore" button.
4. In the "Restore segment" dialog, select the corresponding backup file for the segment you want to restore.
5. Click "Restore".

Result

The restored segments are displayed in the "Archive segments" area on the "Backup/Restore" dashboard.

You can access the data of the restored segment from the WinCC Server, WinCC Client or the Information Server.

Note

If you have created more than one backup of a segment, you can only use the last backup file created to restore the segment.

3.3.4.8 Setting segments "Offline"

Introduction

When a Runtime segment turns into an archive segment, you can back up the archive segment. After successful backup, you can set the archive segment from the Process Historian "Offline". You can only set individual segments "Offline".

After setting a segment "Offline", only the information on restoring the backed up segment is stored in the Process Historian.

You can configure automatic setting to "Offline" together with the automatic backup.

Requirement

- A backup has already been created for the segment.
- The segment has been marked as "valid" in the "Backup/Restore" dashboard. A segment is marked as "invalid", for example, when additional Runtime data for the segment has accumulated after the creation of a backup. In this case, create a backup of the relevant segment again. You can find additional information on this in Backup of segments (Page 56).
Procedure

1. Select the "Backup/Restore" dashboard in the navigation of the Management Console.
2. In the "Archive segments" area, select the segment that you want to set "Offline".
3. Click the "Set offline" button.
   - The entries of the selected segments are moved to the "Restore segments" view.
   - The memory space for these segments is released. You can check the amount of gained space in the "I/O systems" dashboard.

Note

Checking the disk space

To ensure enough free space for the Process Historian during operation, repeat these steps regularly.

Result

The segment is set "Offline" in the Process Historian database.

3.3.4.9 Backing up the database

Overview

You can use the "Database backup" dashboard to create a full backup of the database with the time stamp of backup creation.

The "Current configuration and state" area displays the following information:

- Configured backup type
- Backup state: Progress of the backup copy
- Destination path of backup copies
- Free disk space
- Status
Backing up the database

The data of the Process Historian database is stored in multiple data groups. A backup of the database consists of many individual created files that can contain the following:

- Backup of a single data group
- Backup of the current status of the transaction log after the backup of a data group

The files are created in a specified cycle. If all available data groups are stored in files, the status for this database is displayed as "100%". You can restore the database using these files.

You can select from three options for database backup in the "Settings" area:
● "Disable": The "Database backup" function is disabled.

● "Manual": If all data groups have been saved once to files, the status is displayed as "100%". This completes the database backup. A recovery of the backed up files restores the data up to the time at which the last data group was saved.

● "Automatic": If all data groups have been saved once to files, the status is displayed as "100%". Recovery with the current database backup is possible only from this point in time. In contrast to "Manual", a backup is then continuously made to other files for the oldest data group or a data group that has been changed in the meantime. For this, the oldest backup of this data group is deleted so that the hard disk space does not increase infinitely. Recovery is always possible up to the time at which the last data group was saved.

**Storing the database backup**

**Defining the path**

1. Enter the required drive in the "Destination path" field and a folder with the database name as path.
2. Click "Apply settings". In an overview window you will find the steps to be performed after confirmation.
3. Check your entries.
4. Confirm with "OK" if all the entries are correct. The database is backed up.

**Storage with automatic backup**

The database backup is stored in the specified destination path for the first time. The next backup is saved in the same destination path and the previous backup is deleted. To prevent the loss of previous backups, enter a new destination path when you start the automatic backup.

Example:

The Process Historian-database has the name "HistorianStorage". The destination path is "D:\RecoveryBackups". The backup is saved in the destination path "D:\RecoveryBackups\HistorianStorage".

**Storage with manual backup**

The database backup is stored in the specified destination path. The time stamp with date and time is part of the storage name of the backup.

Example:

The Process Historian database has the name "HistorianStorage". Backup was started on 31 May 2014 at 18:00 hours. This results in the following path and name for the backup: "D:\RecoveryBackups\20140531_1800_HistorianStorage ".

You can save all future backups that you create manually in the same destination path. The existing backups are not changed or deleted.
Storage medium

We recommend that you always store the database backup on a separate drive.
The following external drives can be used as storage media for the backups:

- USB hard disk
- Network drive via ISCSI. You can find information about ISCSI from Microsoft at:

Sufficient memory must be available on the selected storage medium for a complete backup.

**Note**

**Memory requirements**

If less than 20 GB are free on the drive, a warning is displayed on the control system.

A warning is output by the control system and the backup is aborted if there is less than 10 GB available on the drive.

Incomplete backups

If the backup type is changed during backup creation, an incomplete backup cannot be resumed. Incomplete backups cannot be used for recovery.

If there are write errors for the database backup on the drive, it may not be possible to perform a recovery.

Recovery - Recovering a database

With a recovery, you restore the state of the database in the Process Historian to the time at which the data group was last backed up to a file.

You recover the database with the "Database Installation Wizard". Before recovery is started, the database backup is checked for completeness. The recovery process starts only if the backup is complete, which means the backup status is "100%".

**Note**

The name of the destination path is important in a recovery. The name must match the database name. Recovery is not possible when the path is renamed, and an error message is output.
3.3.5 Creating object types

3.3.5.1 Basics of object types

Operand type

At the operand type, you define one of the following methods of analysis via the "Evaluation type":

- "Number": Value analysis. The recorded values are displayed or calculated over a period of time, e.g. minimum, maximum or average.

- "Timer/Counter": Time series analysis. An operand of the "Timer/Counter" type counts states based on a configured limit. The following is determined during the calculation depending on the "Evaluation type" of the operand instance:
  - Time: "How long was a value above a certain value?"
  - Counters: "How often was a value above a certain value?"

Note

Use the "Number" "Evaluation type" to record values of "External Counting".

- "Structured operand": Similar to time series analysis. You map the state model of a plant in a structured operand by assigning states to numerical values or number ranges. Each state is treated as an operand.

Operand formula

In the operand formula, you calculate from one or more process values a value that is not provided by the process. You assign the result of the operand formula to an operand instance instead of a WinCC tag.

Example:

The "PUMPSTATE" operand type is used to store the operating mode of various pumps. A type "A" pump supplies the operating mode directly. Another pump of the type "B" supplies the speed (RPM) as well.

With a type "A" pump, the pump is considered activated when the operating mode signals "ON". With a type "B" pump, the speed is also relevant. The operating mode is considered "ON" only when the speed exceeds a certain value and the operating mode signals "ON". The WinCC tags for speed and operating mode are logically linked in the operand formula.

To be able to evaluate the operating mode with an operand type only, you can connect the "PUMPSTATE_1" operand instance directly to the WinCC tag. You connect the "PUMPSTATE_2" operand instance to the operand formula.
KPI type

In the KPI type, you define a formula to calculate multiple operands, constants or KPIs.

Context information type

You use context information types to store metadata for your equipment. Context information types are relevant for the evaluation of KPIs. A context information type corresponds to a category, e.g. "Manufacturer", "Type" or "Operator". Based on detailed context information, for example, you can show why the plant has failed more frequently with a product of "Manufacturer A".

The following table shows examples for context information types:

<table>
<thead>
<tr>
<th>Context information</th>
<th>Entries for each piece of context information(^1)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>String</em> data type</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Manufacturer A</td>
</tr>
<tr>
<td>Operator</td>
<td>Operator 1</td>
</tr>
<tr>
<td>Operator</td>
<td>Operator 3</td>
</tr>
<tr>
<td>Type</td>
<td>Manufacturer B</td>
</tr>
<tr>
<td>Operator</td>
<td>Operator 1</td>
</tr>
<tr>
<td>Operator</td>
<td>Operator 2</td>
</tr>
</tbody>
</table>

\(^1\) Select an entry for each use of a context information instance at a piece of equipment. Alternatively, you can also refer to the entry from a WinCC tag.

See also

Creating an operand type (Page 71)
Creating a structured operand type (Page 74)
Creating a KPI type (Page 76)
Creating equipment (Page 77)
Creating the context information type (Page 78)
Example: Using an operand of "Timer/Counter" type (Page 85)
Example: Using an operand of the type "External counter" (Page 86)
3.3.5.2 Cyclic output of a KPI calculation in WinCC tag

Introduction

You can calculate a KPI cyclically in Runtime and store the result in a WinCC tag with a process connection. In this way, for example, you can create a line dashboard or store the values in WinCC Tag Logging.

The calculation is always performed cyclically from the current point in time to a definable point in time in the past.

Calculation methods

The following calculation methods are available:

<table>
<thead>
<tr>
<th>Calculation methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyclic - interrupted</td>
<td>The KPI is calculated once within a cycle.</td>
</tr>
<tr>
<td>Cyclic - continuous</td>
<td>The KPI is calculated cyclically as of a specific point in time.</td>
</tr>
<tr>
<td>Cyclic - interval</td>
<td>The KPI is calculated cyclically with an interval.</td>
</tr>
<tr>
<td>Tag controlled - cyclic</td>
<td>When the trigger occurs, the KPI is calculated within a cycle until the start of the cycle.</td>
</tr>
<tr>
<td>Tag controlled - interrupted</td>
<td>When the trigger fires, the KPI is calculated for the specified time period.</td>
</tr>
</tbody>
</table>

The following additional configuration options are available depending on the calculation method:

<table>
<thead>
<tr>
<th>Configuration options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interval</td>
<td>Time period that is calculated starting with the trigger or the anchor point.</td>
</tr>
<tr>
<td>Calculated time period</td>
<td>Time period which is calculated starting with the anchor point.</td>
</tr>
<tr>
<td>Return</td>
<td>Time period of one cycle. The time period for the &quot;Return&quot; must be greater than the time period for the &quot;Interval&quot;.</td>
</tr>
<tr>
<td>Anchor point</td>
<td>Point in time as of which the calculation for the next occurrence of the point in time is performed (constant). The anchor point can also be set as tag.</td>
</tr>
</tbody>
</table>
3.3 Working with the PerformanceMonitor

Principle

You define the required calculation cycles for each KPI type. You define how often and for how long values are calculated for each calculation cycle. The following figure shows a KPI type with three calculation cycles:

You then select the required calculation cycles at the KPI instance. For each calculation cycle, you select the WinCC tag in which the calculation result is stored. The following figure shows a KPI instance with three calculation cycles:
Setting anchor point as tag

You define the anchor point for a calculation cycle as tag if you want to control it with a CPU. Select the entry "Tag" in the properties under "Anchor point".

At the KPI instance, you select the required tag in the properties under "Anchor point data source". Under "Calculated value", you select the target tag.
If you want to define the duration of a WinCC tag, the tag must meet the following requirements:

- Data type: Text tag, 16-bit character set
- Format of the time information: PnnYnnMnnWnnDTnnHnnMnnS according to ISO 8601
  "P" initiates the specification of a duration.
  "P" initiates the specification of a time of day.

The following table shows an example for specifying time durations:

<table>
<thead>
<tr>
<th>Format</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>P2Y10M15DT10H30M20S</td>
<td>2 years 10 months 15 days 10 hours 30 minutes 20 seconds</td>
</tr>
<tr>
<td>P6W</td>
<td>6 weeks</td>
</tr>
<tr>
<td>PT72H</td>
<td>72 hours</td>
</tr>
<tr>
<td>P120D</td>
<td>120 days</td>
</tr>
</tbody>
</table>

The following figure shows the use of a WinCC tag to specify a variable time range. The time range is written to the WinCC tag via an IO field:
3.3 Working with the PerformanceMonitor

3.3.5.3 Creating an operand type

Introduction

At the operand type, you define one of the following analysis methods using the "Evaluation type":

<table>
<thead>
<tr>
<th>Evaluation type</th>
<th>Analysis method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Value analysis</td>
<td>The recorded values are displayed or calculated over a period of time, e.g. minimum, maximum or average.</td>
</tr>
</tbody>
</table>
| Timer/Counter         | Time series analysis| An operand of the "Timer/Counter" type counts states based on a configured limit. The following is determined during the calculation depending on the "Evaluation type" of the operand instance:  
  - Time: How long was a value above a certain value?  
  - Counter: How often was a value above a certain value? |
| Structured operand    | Time series analysis| You map the state model of a plant in a structured operand by assigning states to numerical values or number ranges. Each state is treated as an operand. |

Note

Use the "Number" "Evaluation type" to record values of "External Counting".

See also

Creating a KPI type (Page 76)

Sample project for WinCC/PerformanceMonitor (http://support.automation.siemens.com/WW/view/en/74509647)
Requirement

If you want to assign a structured operand type to an operand type, you first have to create a structured operand type.

You can find additional information under:
- Structured operand type (Page 74)

Procedure

1. Navigate to "Types > Operands" in the navigation area.
2. Select the next empty cell under "Name" in the table area and enter the name of the operand type.
3. Select the "Evaluation type". When a structured operand type is created, it is displayed in the evaluation type and can be selected.
4. If necessary, make the following settings in the "Properties" window:
   - Bar color and text color for display in the Runtime control
   - Display name for the display in the Runtime control
   - Unit
   - Comment
   - Tooltip

Using an operand type in a KPI formula

For the operand type to appear in the calculation of a KPI, the operand type must be used in a KPI formula.

Display in the formula editor

Each state is considered a separate operand. When you enter a formula, the value can be addressed via "Operand.status.time" or "Operand.status.counter".

You can find additional information under:
- Creating a KPI type (Page 76)

See also

Name (Page 152)
Evaluation type (Page 152)
Basics of object types (Page 65)
Example: Using an operand of "Timer/Counter" type (Page 85)
Example: Using an operand of the type “External counter” (Page 86)
Assigning parameters to an operand instance of the type “External counter” (Page 83)

### 3.3.5.4 Creating an operand formula

**Introduction**

In the operand formula, you calculate from multiple process values a value that is not provided by the process. You create a parameter with a data type for each process value to be processed. You then define a calculation formulate from the parameters.
Procedure

1. Navigate to "Types > Operand Formula" in the navigation area.
2. Select the next empty cell under "Name" in the table area and enter the name of the operand formula.
3. Select the "Evaluation type".
4. Open the formula editor in the "Calculation Statement" column with the "..." button and define your calculation formula.
5. Select the "Operand Parameters" tab in the table area. Alternatively, navigate to your newly created operand formula in the navigation area under "Types > Operand Formula > ...".
6. Specify the operand parameters "Name", "Data type" and "Group type".

See also

Name (Page 152)
Calculation formula (Page 152)
Evaluation type (Page 152)
Data type (operand formula) (Page 153)

3.3.5.5 Creating a structured operand type

Import state model from XML file

To import an existing OMAC state model, select the menu command "Templates > Structured Operands > [Name]" in the PerformanceMonitor. The XML files are located in the WinCC installation directory under "PerformanceMonitor\bin".

Procedure

1. Navigate to "Types > Structured Operands" in the navigation area.
2. Select the next empty cell under "Name" in the table area and enter the name of the structured operand type.
3. Select the "Structured Operand Entries" tab in the table area. Alternatively, navigate to your newly created structured operand in the navigation area under "Types > Structured Operands".
4. Specify the parameters "Min", "Max" and "Group type".

5. If necessary, make the following settings in the "Properties" window:
   – Bar color and text color for display in the Runtime control
   – Display name for the display in the Runtime control
   – Unit
   – Comment
   – Tooltip

Result

The list with the entries for a structured operand has been defined.

Assigning structured operand type to an operand type

For the structured operand to appear in the calculation of a KPI, the structured operand type must be assigned to an operand type. To do so, select a structured operand type with the "Evaluation type".

You can find additional information under:
- Creating an operand type (Page 71)

See also

- Basics of object types (Page 65)
- Name (Page 152)
3.3.5.6 Creating a KPI type

Introduction

In the "Key Performance Indicator" type, you define a formula to calculate multiple operands, constants or KPIs. You define the calculation cycles in the created KPI.

Requirement

Operand types have been created.

Procedure

1. Navigate to "Types > Key Performance Indicators" in the navigation area.
2. Select the first empty cell under "Name" in the table area and enter the name of the KPI type.
3. Open the formula editor in the "Calculation Statement" column with the "..." button and define the calculation formula with which the KPI is being calculated. The created operand types that you can use for the calculation are displayed in the Details view in the formula editor.
4. If necessary, make the following settings in the "Properties" window:
   - Bar color and text color for display in the Runtime control
   - Display name for the display in the Runtime control
   - Unit
   - Comment
   - Tooltip
5. Select the "Calculation Cycles" tab in the table area. Alternatively, navigate to your newly created KPI in the navigation area under "Types > Key Performance Indicators".
6. Specify the parameters "Name", "Method" and "Group type".
7. For a cyclic calculation in Runtime, select the "Anchor point" from which the calculation is to be performed cyclically.

See also

Name (Page 152)
Calculation formula (Page 152)
Unit (Page 153)
Creating an operand type (Page 71)
3.3.5.7 Creating equipment

Introduction

Equipment has one of two forms in the PerformanceMonitor Configuration Studio:

- Plant
- Group

You can assign one or more "Plant" equipment forms to the "Group" equipment form. In this way, you can define, for example, simple production lines with one hierarchy level.

Procedure

1. Click "Equipment Configuration" in the navigation area.
2. Select the first empty cell under "Name" and enter the name of the equipment group.
3. Select the "Equipments" tab in the table area.
   Alternatively, navigate to your newly created equipment group in the navigation area under "Equipment Configuration".
4. Select the first empty cell under "Name" and enter the name of the equipment. The "group type" is set automatically after entering the name. The "group type" can be changed at any time.

5. If necessary, make the following settings in the "Properties" window:
   - Bar color and text color for display in the Runtime control
   - Display name for the display in the Runtime control
   - Unit
   - Comment
   - Tooltip

See also

Name (Page 152)
Grouping (Page 152)
Basics of object types (Page 65)

3.3.5.8 Creating the context information type

Introduction

Context information is evaluation and filter criteria that describe a piece of equipment in detail. You assign context information to sort or filter the display of KPIs depending on the equipment according to these criteria.

You can create context information in the following way, for example:

- Create a list with the pre-defined values.
- Use a WinCC tag in which information from the plant is stored.

Procedure

1. Navigate to "Types > Context Information" in the navigation area.
2. Select the first empty cell under "Name" in the table area and enter the name of the context information type.
3. If you want to read in the entries for the context information from a WinCC tag in Runtime, select the data type of the WinCC tag under "Data type".
4. Select the "Context information entries" tab in the table area. Alternatively, navigate to your newly created context information in the navigation area under "Types > Context information".
5. Select the first empty cell under "Name" and enter the name of the context information entry. The "group type" is set automatically after entering the name. The "group type" can be changed at any time.

6. If necessary, make the following settings in the "Properties" window:
   - Bar color and text color for display in the Runtime control.
   - Display name for the display in the Runtime control
   - Comment
   - Tooltip

See also
Basics of object types (Page 65)

3.3.6 Configuring object instances

3.3.6.1 Assigning the KPI type to equipment

Introduction
You assign KPIs to one or more items of equipment using drag-and-drop.

Requirement
- KPI type and associated operand types have been defined.
- The equipment has been created.

Procedure
1. Navigate to "Instances > [Equipment Group] > [Equipment] > Key Performance Indicator" in the navigation area.
2. Navigate to "Types > Key Performance Indicators" in the navigation area and drag the required Key Performance Indicator to the instance.

Result
The operand types used in the KPI types are available under "Instances > [Group] > [Equipment] > Key Performance Indicator > Operands".
To assign parameters to the KPI instance, link the operand instances to values, tags or operand formulas.
3.3.6.2 Configuring a KPI instance

Introduction

Depending on the associated KPI type, a KPI instance may contain cyclic calculations. In the instance, connect your created calculation cycle to a WinCC tag.

Requirement

- KPI is assigned to equipment.
- Calculation cycle is defined in the KPI.
- The KPI instance is selected.
- The WinCC tags for the value supply have been created.

Procedure

1. Navigate to "Instances > [Equipment Group] > [Equipment] > Key Performance Indicators" in the navigation area.
2. Select the required KPI.
3. In the "Name" column, select the previously defined calculation cycle.
4. Click the ".." button in the "Calculated value" column.
   The "tag selection" dialog is displayed.
5. Select the required WinCC tag for your calculation.
6. Confirm your selection with "OK".

3.3.6.3 Configuring an operand instance of the "Timer/Counter" type

Requirement

- The path "Instances > [Equipment Group] > [Equipment] > Operands" is displayed in the navigation area.
- The operand type has the "Timer/Counter" evaluation type.
- KPI with this operand instance is assigned to an item of equipment.

Procedure

1. Navigate to "Instances > [Equipment Group] > [Equipment] > Operands".
2. Select the "Connection mode" in the operand instance.
3. Enter the "Data source" depending on the selected "Connection mode".
4. Select the "Acquisition cycle".
5. Select the "Data type".
6. Select the required "Calculation mode".
7. If necessary, enter the "Settling time".

**Result**

The operand instance of the "Timer/Counter" type is configured.

![Diagram of operand instance configuration](image)

**See also**

Assigning the KPI type to equipment (Page 79)
Connection mode (Page 155)
Connect with (Page 155)
Data source (Page 155)
Data source cycle (Page 155)
Data type (operand instance) (Page 155)
Calculation mode (Page 156)
Settling time (seconds) (Page 156)
Example: Using an operand of "Timer/Counter" type (Page 85)

### 3.3.6.4 Configuring an operand instance of the "Number" type

**Requirement**

- The path "Instances > [Equipment Group] > [Equipment] > Operands" is displayed in the navigation area.
- The operand type has the "Number" evaluation type.
- KPI with this operand instance is assigned to an item of equipment.
Procedure

1. Navigate to "Instances > [Equipment Group] > [Equipment] > Operands".
2. Select the "Connection mode" in the operand instance.
3. Enter the "Data source" depending on the selected "Connection mode".
4. Select the "Acquisition cycle".
5. Select the "Data type".
6. Select the required "Calculation mode".

Result

The operand instance of the "Number" type is configured.

See also

Assigning the KPI type to equipment (Page 79)
Connection mode (Page 155)
Connect with (Page 155)
Data source (Page 155)
Data source cycle (Page 155)
Data type (operand instance) (Page 155)
Calculation mode (Page 156)
3.3.6.5 Assigning parameters to an operand instance of the type "External counter"

Requirement
- The path "Instances > [Equipment Group] > [Equipment] > Operands" is displayed in the navigation area.
- The operand type has the "Number" evaluation type.
- KPI with this operand instance is assigned to an item of equipment.

Procedure
1. Navigate to "Instances > [Equipment Group] > [Equipment] > Operands".
2. Select the connection mode "Tag" in the operand instance.
3. Under "Data source (Tag/Formula)", select the tag that stores the counter value.
4. Select the "Evaluation cycle".
5. Select the "Data type".
6. Select the entry "External counter" under "Calculation mode".
7. Configure the "External counter":
   - Under "Counter minimum" and "Counter maximum", define the counting range.
   - To save the current counter value, select the WinCC tag that triggers the event under "Counter save event".
   - If you want to save and then reset the current counter value, select the WinCC tag that triggers the event.

Note
The values of the WinCC tags for saving and resetting the counter status must be set by either the operator or the controller. The corresponding event in the PerformanceMonitor is triggered only by this external value change.
3.3 Working with the PerformanceMonitor

3.3.6 Configuring context information

Introduction

You assign context information to equipment with drag-and-drop. Context information, for example, can include the "Manufacturer" of the respective item of equipment.

Procedure

1. Navigate to "Instances > [Equipment Group] > [Equipment] > Context information" in the navigation area.
2. Navigate to "Types > Context Information" in the navigation area and drag the required context information to the instance.
3. Under "Connection mode", select the type of data supply.
4. Select the data source under "Data source".
3.3.6.7 Example: Using an operand of "Timer/Counter" type

Introduction

The speed of a motor is used to determine when the motor is considered "on" and when it is "off".

Requirement

An operand type of "Timer/Counter" type has been created.

Procedure

Depending on the data type of the operand, you define the limit or range that is interpreted as the Boolean value "true" as the "calculation method".

When the motor is operated at a constant speed, select "Greater than [value]" as the "Limit". When the motor speed is more irregular, select "Within [range specification]", for example, as the "Limit". You can also eliminate minor speed variations at the range limits by entering a time period under "Settling time". The "Limit" must then be present for at least the length of the "Settling time" before the status is saved.

Result

The following figure shows the course of a process value that is linked to an operand. Value changes above and below the defined limits are ignored.

---

① High limit violation. The "On" state is stored with a time stamp in the operands.
② Low limit violation. The "Off" state is stored with a time stamp in the operands.
③ High limit violation. The "On" state is stored with a time stamp in the operands.
④ Low limit violation. The "Off" state is stored with a time stamp in the operands.
3.3 Working with the PerformanceMonitor

3.3.6.8 Example: Using an operand of the type "External counter"

Introduction
A plant produces two different types of products.
The plant runs 24 hours in a three-shift operation.
The counter is processed in the controller, e.g. Count or Reset.

Requirement
- An operand type "PCounter" of the "Number" type has been created.
- KPI type "ProductCounter" with formula "ProductCounter*1" has been created.
- The following external WinCC tags have been created:
  - ItemCounter: Tag for querying the counter value from the PLC
  - ShiftChange: Tag for triggering the "Shift change" event
  - ProductChange: Tag for triggering the "Product change" event
Procedure

In the object properties of the operand, configure the "External counter" as shown below:
Result

The figure below shows the various counter values stored in the operand over a period of 24 hours:

![Diagram showing counter values over 24 hours]

- **Total counter**: WinCC tag "ItemCounter" that is connected to the "Data source (Tag/Formula)" field.
- **Shift counter**: WinCC tag "ShiftChange" that is connected to the "Data source (Tag/Formula)" field.
  - Event is triggered at the end of a shift. The current counter value is saved with time stamp in the operand and then reset.
- **Product counter**: WinCC tag "ProductChange" that is connected to the "Data source (Tag/Formula)" field.
  - Event is triggered at a product change. The current counter value is saved with time stamp in the operand.
  - You can determine the correct result in the evaluation only when you save the counter value along with the change of context.

See also

- Assigning parameters to an operand instance of the type "External counter" (Page 83)
- Basics of object types (Page 65)
- Creating an operand type (Page 71)

### 3.3.7 Exporting and importing configuration data

#### 3.3.7.1 Basics

**Introduction**

You can export all configuration data from the PerformanceMonitor Configuration Studio to the following file formats:

- TXT
- XLSX
To save configuration time, you can distribute these configuration files over several WinCC projects, for example, and import them into the PerformanceMonitor Configuration Studio.

**Automatic validation of the configuration data**

Before the import, the plausibility of the files is checked with regard to the validity and logic of the configuration data. We distinguish between the following results:

- Import possible
- Import not possible

Errors during the import are logged in the following log file: C:\ProgramData\Siemens\Logs \PerformanceMonitor

**Import possible**

Result of the plausibility check: The file structure is valid. The configuration data is error-free:

- The configuration data is imported in full.
- Configuration data with the same name already existing in the PerformanceMonitor Configuration Studio is overwritten during the import.
- Configuration data with names not contained in the file are retained unchanged.

The figure below shows in schematic form the import of three KPIs into an existing configuration:

1. Configuration data in PerformanceMonitor Configuration Studio before the import.
2. Configuration data in PerformanceMonitor Configuration Studio after the import. The configuration data of KPIs "A", "B" and "D" were overwritten during import. The configuration data of KPI "C" is also unchanged after the import.
3.3 Working with the PerformanceMonitor

3.3.7.2 Exporting configuration data

Requirement
Configuration data is contained in the PerformanceMonitor Configuration Studio.

Procedure
2. Enter a file name for the export file.
3. Select the required file format.
4. Navigate to preferred storage location.
5. Click "Export".

Result
The configuration data is exported to a file. You can adapt the contents of the file, if necessary.

See also
Basics (Page 88)
Importing configuration data (Page 91)
3.3.7.3 Importing configuration data

Introduction

You can only select one import file per import.

Note
Existing configuration data is overwritten during the import
Configuration data with the same name already existing in the PerformanceMonitor Configuration Studio is overwritten during the import.

Requirement

- The import file with exported configuration data is stored in the file system.
- Import file is valid.

Procedure

1. Select "Edit > Import" in the menu bar.
   The file selection dialog opens.
2. Select the file for import.
   The plausibility of the configuration data is checked. That data that is imported depends on the result of the plausibility check.
3. Click "Import".
4. Save the configuration with <Ctrl+S> or select "File > Save" in the menu bar.
5. If necessary, create the WinCC tags whose names are used in the newly imported configuration data.

Result

All valid configuration data is imported.

See also

Basics (Page 88)
Exporting configuration data (Page 90)
3.3.8 Access PerformanceMonitor controls with VBS

Introduction

The controls of the PerformanceMonitor support the dynamization with local VB scripts, in particular for the following configuration settings:

- Add/remove equipment
- Add/remove KPIs
- Add/remove operands
- Configure time range
- Grouping
- Filtering
- Sorting

You can implement individual configuration options with VB scripts, for example, without the user having to open the configuration dialog of a control in Runtime.
Example

The figure below uses the PerformanceViewControl as an example to demonstrate how its configuration can be implemented without using the configuration dialog in Runtime. The VB scripts are configured as local scripts on buttons.

Access to contents of a control

The following PerformanceMonitor objects are included in lists which you access with the following methods:

- **Equipment**: Access with "GetEquipmentCollection".
- **KPIs**: Access with "GetKPICollection".
- **Operands**: Access with "GetOperandCollection".

---

1. Deleting all contents
   Code example "ClearContents"
2. Adding/removing two items of equipment to/from the existing configuration
   Code example "AddRemoveEquipment"
3. Adding/removing two KPIs to/from the existing configuration
   Code example "AddRemoveKPI"
4. Switching between two time ranges
   Code example "ConfigureTimeFrame"
5. Grouping and filtering by context information
   Code example "GroupAndFilterByContextInformation"
3.3 Working with the PerformanceMonitor

- Time ranges: Access with "GetTimeFrameCollection".
- Filters: Access with "GetSpecFilterCollection".

**Note**
Additional information on access to control methods and properties is available in the WinCC information system under the keyword "VBS reference".

**Example "ClearContents"**

In the following example, all the contents are removed from the control:

```vbs
Sub OnClick(ByVal Item)
    ' Define variables
    Dim perfCtrl, equipments, eq, kpis, kpi, filters, filterItem

    ' Initialize variables
    Set perfCtrl = ScreenItems("PerformanceViewControl1")
    Set equipments = perfCtrl.GetEquipmentCollection()
    Set kpis = perfCtrl.GetKPICollection()
    Set filters = perfCtrl.GetSpecFilterCollection()

    ' Remove all contents from control
    For Each eq In equipments
        equipments.RemoveItem(eq.Name)
    Next
    For Each kpi In kpis
        kpis.RemoveItem(kpi.Name)
    Next
    For Each filterItem In filters
        filters.RemoveItem(filterItem.Name)
    Next

    ' Re-initialize control
    perfCtrl.ContextGroupBy = Empty
    perfCtrl.ReloadData
End Sub
```
Example "AddRemoveEquipment"

In the following example, the equipment "CapApplicator" is added:

```vbscript
Sub OnClick(ByVal Item)
    Dim perfCtrl, equipments
    Set perfCtrl = ScreenItems("PerfomanceViewControl1")
    Set equipments = perfCtrl.GetEquipmentCollection()

    ' Add equipment using the method "AddItem"
    equipments.AddItem("CapApplicator")

    ' Re-initialize control
    perfCtrl.ReloadData
End Sub
```

In the following example, the equipment "CapApplicator" is removed:

```vbscript
Sub OnClick(ByVal Item)
    Dim perfCtrl, equipments
    Set perfCtrl = ScreenItems("PerfomanceViewControl1")
    Set equipments = perfCtrl.GetEquipmentCollection()

    ' Remove equipment using the method "RemoveItem"
    equipments.RemoveItem("CapApplicator")

    ' Re-initialize control
    perfCtrl.ReloadData
End Sub
```

Example "AddRemoveKPI"

In the following example, the KPI "Availability" is added:

```vbscript
Sub OnClick(ByVal Item)
    Dim perfCtrl, kpis
    Set perfCtrl = ScreenItems("PerfomanceViewControl1")
    Set kpis = perfCtrl.GetKPICollection()

    ' Add KPI using the method "AddItem"
    kpis.AddItem("Availability")

    ' Re-initialize control
    perfCtrl.ReloadData
End Sub
```
In the following example, the KPI "Availability" is removed:

Sub OnClick(ByVal Item)
    Dim perfCtrl, kpis
    Set perfCtrl = ScreenItems("PerfomanceViewControl1")
    Set kpis = perfCtrl.GetKPICollection()
    ' Remove KPI using the method "RemoveItem"
    kpis.RemoveItem("Availability")
    ' Re-initialize control
    perfCtrl.ReloadData
End Sub

Example "ConfigureTimeFrame"
In the following example, a fixed time range is defined from which the calculated KPIs are displayed:

Sub OnClick(ByVal Item)
    Dim perfCtrl, Timeframes, TimeframeItem, timeframe
    Set perfCtrl = ScreenItems("PerfomanceViewControl1")
    Set Timeframes = perfCtrl.GetTimeFrameCollection()
    ' Remove every existing time frame'
    For Each timeframe in TimeFrames
        TimeFrames.RemoveItem(timeframe.Name)
    Next
    ' Create new timeframe with static start and end
    Timeframes.AddItem("Early Shift")
    Set TimeframeItem = Timeframes("Early Shift")
    With perfCtrl
        .TimeframeBarWindow = "BarWindow1"
        .TimeframeMode = 0 'MODE_BEGIN_TO_END
        .TimeframeBegin: CDate("11/08/2014 05:00:00 AM")'Start time for the request
        .TimeframeEnd: CDate("11/08/2014 01:00:00 PM")'Endtime for the request
    End With
    ' Re-initialize control
    perfCtrl.ReloadData
End Sub
Example "GroupAndFilterByContextInformation"

In the following example, existing context information is grouped according to specific context information:

Sub OnClick(ByVal Item)
    Dim perfCtrl
    Set perfCtrl = ScreenItems("PerfomanceViewControl1")
    perfCtrl.ContextGroupBy = "Supplier"

    ' Re-initialize control
    perfCtrl.ReloadData
End Sub

In the following example, the context information is also filtered:

Sub OnClick(ByVal Item)
    Dim perfCtrl, specifications, filterItem
    Set perfCtrl = ScreenItems("PerfomanceViewControl1")
    Set specifications = perfCtrl.GetSpecFilterCollection()

    ' Add new filter
    specifications.AddItem("FilterEqualsTo")

    'Configure filter "Supplier = Siemens"
    Set filterItem = specifications("FilterEqualsTo")
    With filterItem
        .SpecId = "Supplier" 'Defines the context information's category
        .Operator = 0 ' meaning "="
        .Operand = "Siemens" 'Defines the value
    End With

    perfCtrl.ContextGroupBy = "Supplier"

    ' Re-initialize control
    perfCtrl.ReloadData
End Sub

See also

GetEquipmentCollection method (Page 157)
GetKPIICollection method (Page 158)
GetOperandCollection method (Page 159)
GetSpecFilterCollection method (Page 160)
GetTimeFrameCollection method (Page 161)
3.4 Outputting KPIs

3.4.1 Basics on outputting KPIs

Introduction
You output KPIs in a picture or a report in the following controls:
- WinCC PerformanceViewControl
- WinCC PerformanceGanttControl
- WinCC PerformanceTable Control
You can also use the SIMATIC Information Server or WinCC/WebNavigator.

Time ranges
A time range is the basis for outputting a KPI. You define a time range based on a time t and a time duration. The KPIs are calculated from the acquired operands within this time range.

- Time period with a relative start time

  ![Time period with a relative start time diagram]

  - $t_a$: Current time
  - $t$: Any time in the past

- Start time and duration

  ![Start time and duration diagram]

  - $t_a$: Current time
  - $t_1$: Any time in the past

- Time period with reference time

  ![Time period with reference time diagram]

  - $t_a$: Current time
  - $t_1$: Any time in the past

- Static time range

  ![Static time range diagram]

  - $t_a$: Current time
  - $t_1$: Start time
  - $t_2$: End time

Application example: Cause and effect of a fault signal from two days ago should be determined. To determine the cause, define a "Time period with reference time". To determine the effects, define a "Start time and duration".
Compare

With a comparison, you display a KPI in two time axes with different time ranges, for example, the current month and the previous month.

Filtering and grouping

You define the filters and the grouping of the equipment as well as the context information in the configuration dialog of the control in the "Context Information" tab:

- "Filtering" involves limiting the time range to one or more items of context information.
- "Grouping" involves placing the KPIs in groups according to context information.

The figure below shows the grouping according to context information "Supplier".

Sorting

You specify the sequence of operands and KPIs separately for KPIs and operands in the "Display" tab under "Sorting of bars" in the configuration dialog.

- When you select "0 - Manual", the sequence defined in the "Indicators" or "Operands" tab is used for sorting.
- In the PerformanceViewControl, sorting by operands is only possible with active "Drilldown".

The following figure shows the sorting of KPIs by ascending values:
3.4.2 Controls for displaying the KPIs

Introduction

You can use the following WinCC controls for output:

- **WinCC PerformanceViewControl** and **WinCC PerformanceGanttControl** for graphical output of KPIs in a performance chart.
  Use these output options for continuous evaluation and analysis of KPIs and/or operands.

- **WinCC PerformanceTableControl** for tabular output of the raw data of the operands.
  Use this output option to correct the raw data, for example, when incorrect data is recorded.

You can find more information on configuring controls in the WinCC online help in the WinCC Information System.
Requirement

To use the controls for the WinCC PerformanceMonitor in the Graphics Designer, you must add the controls via the "ActiveX controls" shortcut menu before using them for the first time. The controls are then available under "ActiveX controls". You can drag-and-drop the controls into the screen.

Safety aspects

Take into consideration the assignment of permissions during configuration. Restrict the configuration options in Runtime as needed.

You can find additional information on this topic in the WinCC Online Help in the WinCC Information System under "Working with WinCC > Configuration of the User Administration".

See also

Basics on outputting KPIs (Page 98)
3.4.3 Configuring in the Report Designer

The WinCC PerformanceMonitor provides the following objects for the Report Designer:

- **Layouts:**
  - @Performance Monitor Control - Picture
  - @Performance Monitor Control - Table

- **Print jobs:**
  - @Performance Monitor Table Control - Table
  - @Performance Monitor Gantt Control - Picture

- **Controls for output in reports and logs**
  - CCAxPerformanceGanttControl
  - CCAxPerformanceTableControl
  - CCAxPerformanceViewControl

3.4.4 WinCC PerformanceViewControl

3.4.4.1 Configuring WinCC PerformanceViewControl

**Introduction**

You can configure the graphical output of KPIs or operands in a PerformanceViewControl in the configuration dialog of the WinCC PerformanceViewControl.

**Requirement**

- The Graphics Designer is open.
- KPIs, operands, equipment and context information have been configured.

**Procedure**

1. Insert the "WinCC PerformanceViewControl" in a process picture.
2. Open the configuration dialog with a double-click on the WinCC PerformanceViewControl.
3. Define the parameters in the following tabs:

  **"Equipment" tab**

  Define the equipment for which you want to display the KPIs and operands in the performance chart.
3.4 Outputting KPIs
1. Click on "New..." below the "Equipment" list. The "Equipment selection" dialog opens.

2. Select the desired equipment. Multiple selection with <Ctrl> is supported. The KPIs associated with the equipment are added automatically.

3. Confirm your selection with "OK".

4. In the "Equipments" list, specify the sequence for the display in the performance chart with the "Up" and "Down" buttons.

5. If necessary, edit the other display properties, such as color or object name.

"Indicators" tab
Define the KPIs that you want to evaluate in the performance chart. Under "Gradient", enter the fill pattern and fill pattern color of the bars.
"Time ranges" tab
Define the time periods for the performance chart.
1. Set the number and sequence of time ranges in the "Time range" list.

2. Enter the duration for each list entry in the "Time range" section. If necessary, also specify a starting point or reference point.

3. If necessary, edit the other display properties, such as object name.

You can find additional information on defining time ranges under:

- Basics on outputting KPIs (Page 98)

"Axes" tab

Define the type, scale and label of the axes in the performance chart. Note that the axes can be assigned to both KPIs and operands.
1. Set the number and sequence of axes in the "Axes" list.
2. Enter a scaling for each list entry in the "Range" section.
3. If necessary, edit the other display properties, such as object name.

"Appearance" tab
Define the bar appearance for display in the performance chart. If you want to let the bars overlap, select the entry "Activate cascading" under "Cascade bars" and enter a percentage value.
"Context information" tab

If necessary, define filter criteria and/or grouping for the display in the performance chart in the "Context information" tab. You can define or change both the filtering and the grouping in Runtime.
You can find additional information on defining context information under:

- Basics on outputting KPIs (Page 98)

**Note**

**Strong influence on the performance**

Configuring filters and groupings affects the calculation time for the output in the Runtime Control.

If possible, test the configuration without connecting to the process.

### 3.4.4.2 Operating WinCC PerformanceViewControl in Runtime

**Note**

The following operator actions are supported in the WebNavigator.
Structure of WinCC PerformanceViewControl

The WinCC PerformanceViewControl is used for graphical output of KPIs in a performance chart and consists of the following areas:

1. Toolbar

The toolbar contains buttons to perform special functions in the WinCC PerformanceViewControl. Depending on the configuration, the following buttons are available for operation:

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Help</td>
<td>Opens the help of the WinCC PerformanceViewControl.</td>
</tr>
<tr>
<td><img src="image" alt="Configuration dialog" /></td>
<td>Configuration dialog</td>
<td>Opens the configuration dialog for editing the properties of the WinCC PerformanceViewControl.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
<td>Starts the printout of the displayed values. You define the print job that is used for printing in the “General” tab of the configuration dialog.</td>
</tr>
<tr>
<td><img src="image" alt="Exporting data" /></td>
<td>Exporting data</td>
<td>Exports selected data to a CSV file.</td>
</tr>
<tr>
<td><img src="image" alt="Reloading" /></td>
<td>Reloading</td>
<td>Refreshes the view in the control.</td>
</tr>
<tr>
<td><img src="image" alt="Cancel" /></td>
<td>Cancel</td>
<td>Stops the evaluation in the control.</td>
</tr>
<tr>
<td><img src="image" alt="Show comments" /></td>
<td>Show comments</td>
<td>Select the KPI or operand. Click &quot;Reload&quot; and then &quot;Show comments&quot;.</td>
</tr>
</tbody>
</table>
### 3.4 Outputting KPIs

#### 3.4.5 WinCC PerformanceGanttControl

#### 3.4.5.1 Configuring WinCC PerformanceGanttControl

**Introduction**

You can configure the graphical output of KPIs or operands in a PerformanceGanttControl in the configuration dialog of the WinCC PerformanceGanttControl.

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Create new comment</td>
<td>Select the KPI or operand. Click &quot;Create new comment&quot; and enter the comment text.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Drilldown</td>
<td>Select the KPI and click &quot;Drilldown&quot;. The assigned operands of the KPI are displayed.</td>
</tr>
</tbody>
</table>

**Display area**

The selected equipment with its KPIs is displayed in the display area. The associated operands are displayed with "Drilldown".

**Group display**

Select the command "Based on > Indicators" or Based on > Equipment" from the shortcut menu of the displayed KPIs.

1. Calculated KPIs grouped by "Equipment"
2. Calculated KPIs grouped by "KPIs"

**Status bar**

The status bar shows the various states of the WinCC PerformanceViewControl.
3.4 Outputting KPIs

**Requirement**

- The Graphics Designer is open.
- KPIs, operands, equipment and context information have been configured.

**Procedure**

1. Insert the "WinCC PerformanceGanttControl" in a process picture.
2. Open the configuration dialog with a double-click on the WinCC PerformanceGanttControl.
3. Define the parameters in the following tabs:

"Equipment" tab

Define the equipment for which you want to display operands in the performance chart.
1. Click on "New..." below the "Equipment" list. The "Equipment selection" dialog opens.

2. Select the desired equipment. Multiple selection with <Ctrl> is supported. The KPIs associated with the equipment are added automatically.

3. Confirm your selection with "OK".

4. In the "Equipments" list, specify the sequence for the display in the performance chart.

5. If necessary, edit the other display properties, such as color or object name.

"Indicators" tab
Define the operands that you want to evaluate in the performance chart. All operands that are assigned to the KPI of the selected equipment are listed in the "Indicators" list.
"Time ranges" tab

Define the time periods for the performance chart.
1. Set the number and sequence of time ranges in the "Time range" list.

2. Enter the duration for each entry in the "Time range" section. If necessary, also specify a starting point or reference point.

3. If necessary, edit the other display properties, such as object name.

You can find additional information on defining time ranges under:
- Basics on outputting KPIs

"Display" tab

Define the display in the performance chart. If you want to display all structured operands in a row, enable the entry "Group structured operands" under "Miscellaneous".
"Context information" tab

If necessary, define filter criteria and/or grouping for the display in the performance chart. You can also configure the filtering and grouping in Runtime.
You can find additional information on defining context information under:

- Basics on outputting KPIs (Page 98)

**Note**

**Strong influence on the performance**

Configuring filters and groupings affects the calculation time for the output in the Runtime Control.

If possible, test the configuration without connecting to the process.

### 3.4.5.2 Operating WinCC PerformanceGanttControl in Runtime

**Note**

The following operator actions are supported in the WebNavigator.
Structure of WinCC PerformanceGanttControl

The WinCC PerformanceGanttControl is used for graphical output of KPIs in a performance chart and consists of the following areas:

1. **Toolbar**

   The toolbar contains buttons to perform special functions in the WinCC PerformanceGanttControl. Depending on the configuration, the following buttons are available for operation:

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📚 Help</td>
<td>Help</td>
<td>Opens the help of the WinCC PerformanceGanttControl.</td>
</tr>
<tr>
<td>💾 Configuration dialog</td>
<td>Configuration dialog</td>
<td>Opens the configuration dialog for editing the properties of the WinCC PerformanceGanttControl.</td>
</tr>
<tr>
<td>🖨 Print</td>
<td>Print</td>
<td>Starts the printout of the displayed values. You define the print job that is used for printing in the &quot;General&quot; tab of the configuration dialog.</td>
</tr>
<tr>
<td>🔍 Exporting data</td>
<td>Exporting data</td>
<td>Exports selected data to a CSV file.</td>
</tr>
<tr>
<td>🔍 Zoom area</td>
<td>Zoom area</td>
<td>You define an area by dragging with the mouse in the display area. The section of the display area is enlarged.</td>
</tr>
<tr>
<td>🔍 Zoom in</td>
<td>Zoom in</td>
<td>Enlarges the display in the display area.</td>
</tr>
<tr>
<td>🔍 Zoom out</td>
<td>Zoom out</td>
<td>Reduces the display in the display area.</td>
</tr>
<tr>
<td>🔍 Original view</td>
<td>Original view</td>
<td>Switches from enlarged display back to the standard view.</td>
</tr>
<tr>
<td>🔄 Reloading</td>
<td>Reloading</td>
<td>Refreshes the view in the control.</td>
</tr>
<tr>
<td>❌ Cancel</td>
<td>Cancel</td>
<td>Stops the evaluation in the control.</td>
</tr>
</tbody>
</table>
### 3.4 Outputting KPIs

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Show comments</td>
<td>Select the timeline of the operand. Click &quot;Reload&quot; and then &quot;Show comments&quot;.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Create new comment</td>
<td>Select the timeline of the operand. Click &quot;Create new comment&quot; and enter the comment text.</td>
</tr>
</tbody>
</table>

**② Display area**

The selected equipment with its operands is displayed in the display area:
- The “Period” column shows the duration of the "On" status in the viewed time period.
- The “Frequency” column shows the number of status changes in the viewed time period.

To display a user-defined tooltip, use the mouse to point to the timeline of an operand.

**③ Status bar**

The status bar shows the various states of the WinCC PerformanceGanttControl.

---

### 3.4.6 WinCC PerformanceTableControl

#### 3.4.6.1 Configuring WinCC PerformanceTableControl

**Introduction**

You configure the tabular output of operands in the configuration dialog of the WinCC PerformanceTableControl.

**Requirement**

- The Graphics Designer is open.
- KPIs, operands, equipment and context information have been configured.

**Procedure**

1. Insert the "WinCC PerformanceTableControl" in a process picture.
2. Open the configuration dialog with a double-click on the WinCC PerformanceTableControl.
3. Define the parameters in the following tabs:

   **"Equipment" tab**
   
   Define the equipment for which you want to output the operands in the table.
3.4 Outputting KPIs
1. Click on "New..." below the "Equipment" list. The "Equipment selection" dialog opens.

2. Select the desired equipment. Multiple selection with <Ctrl> is supported. The KPIs associated with the equipment are added automatically.

3. Confirm your selection with "OK".

4. In the "Equipments" list, specify the sequence for the display in the performance chart.

5. If necessary, edit the other display properties, such as color or object name.

"Indicators" tab

Define the operands for which you want to output the raw data (value and time stamp) in the table.
"Time ranges" tab
Define the time ranges for which the raw data is to be output.
1. Set the number and sequence of time ranges in the "Time range" list.

2. Enter the duration for each entry in the "Time range" section. If necessary, also specify a starting point or reference point.

3. If necessary, edit the other display properties, such as object name.

You can find additional information on defining time ranges under:

- Basics on outputting KPIs

"Columns" tab

Define the number, labeling and appearance of the table columns.
"Context information" tab

If necessary, define the filter criteria for tabular output. You can define or change the filtering in Runtime. Grouping is not possible in the tabular output.
You can find additional information on defining context information under:

- Basics on outputting KPIs (Page 98)

**Note**

**Strong influence on the performance**

Configuring filters and groupings affects the calculation time for the output in the Runtime Control.

If possible, test the configuration without connecting to the process.

"General" Tab

Under "Change values", define whether a user is allowed to change the displayed values in Runtime. The user must have the permission "Change values".
3.4.6.2 Operating WinCC PerformanceTableControl in Runtime

**Note**

The following operator actions are supported in the WebNavigator.
Structure of WinCC PerformanceTableControl

The WinCC PerformanceTableControl is used for tabular output of raw data of the operands and consists of the following areas:

1. Toolbar

The toolbar contains buttons to perform special functions in the WinCC PerformanceTableControl. Depending on the configuration, the following buttons are available for operation:

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📏</td>
<td>Help</td>
<td>Opens the help of the WinCC PerformanceTableControl.</td>
</tr>
<tr>
<td>📲</td>
<td>Configuration dialog</td>
<td>Opens the configuration dialog for editing the properties of the WinCC PerformanceTableControl.</td>
</tr>
<tr>
<td>🔘</td>
<td>Sort dialog</td>
<td>Opens a dialog for setting user-defined sorting.</td>
</tr>
<tr>
<td>📢</td>
<td>Print</td>
<td>Starts the printout of the displayed values. You define the print job that is used for printing in the &quot;General&quot; tab of the configuration dialog.</td>
</tr>
<tr>
<td>📈</td>
<td>Exporting data</td>
<td>Exports selected data to a CSV file.</td>
</tr>
<tr>
<td>🔄</td>
<td>Reloading</td>
<td>Refreshes the view in the control.</td>
</tr>
<tr>
<td>❌</td>
<td>Cancel</td>
<td>Stops the evaluation in the control.</td>
</tr>
<tr>
<td>📝</td>
<td>Show comments</td>
<td>Select the require line. Click &quot;Reload&quot; and then &quot;Show comments&quot;.</td>
</tr>
</tbody>
</table>
3.4 Outputting KPIs

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Create new comment]</td>
<td>Create new comment</td>
<td>Select the require line. Click &quot;Create new comment&quot; and enter the comment text.</td>
</tr>
<tr>
<td>![Change values]</td>
<td>Change values</td>
<td>Activates the &quot;Change values&quot; mode, if you have the necessary authorization. Edit the values in the &quot;Value&quot; column and confirm with &lt;Return&gt;. The authorization is activated in the &quot;General&quot; tab of the configuration dialog.</td>
</tr>
</tbody>
</table>

② Display area

The selected equipment with its operands is displayed in the display area.

③ Status bar

The status bar shows the various states of the WinCC PerformanceTableControl.

3.4.7 Outputting KPIs in the Information Server

3.4.7.1 Creating a PerformanceMonitor report in the Information Server

Introduction

PerformanceMonitor supports the creation of reports in the SIMATIC Information Server. For more information about this topic, refer to the documentation for the Information Server.

Requirement

The WinCC project is activated in Runtime.
Procedure

1. Connect to the home page of the Information Server and log on.
2. Under "Administration", select the SQL server instance ".\WinCC" as "Data source".
3. Select the desired project.
   The available templates of the PerformanceMonitor are listed under "Reporting".
4. Based on a template, create the required report, for example "Performance view: KPI".

① Select the project and time range.
② Select the equipment for which KPIs are to be evaluated.
③ Select KPIs to be evaluated in the report.
④ Group and filter on the basis of available context information.

5. Click "Show report".

See also

Output of KPIs via Excel add-in (Page 131)
3.4.7.2 Output of KPIs via Excel add-in

Introduction

You can output the calculated KPIs in Microsoft Excel with the Excel add-in of the PerformanceMonitor. The Excel add-in uses the Information Server as data source. Use the Report Templates of the Information Server in the "Office" format as templates. You can also save these Report Templates locally.

You can find additional information about installing Excel add-ins in the document "PerformanceMonitor - Installation Notes".

The figure below shows the operator controls of the Excel add-in:

1. Opens the dialog for selecting the project and the KPIs contained in it.
2. Refreshes the data in the spreadsheet.
3. Saves the template:
   - When you click the "Excel" icon, the template is saved on the Information Server.
   - Click "Upload to IS" to save the template in the file system.
4. Opens an existing template:
   - When you click the "Excel" icon, the template is uploaded to the Information Server.
   - Click "Download from IS" to save the template in the file system.
5. Opens the dialog with the connection settings to the Information Server.
   Note: If the Information Server supports the secure connection via "HTTPS", also enable "SSL".

The figure below shows how an individual KPI with additional information is arranged in a spreadsheet:
3.4 Outputting KPIs

1. Selection of the project from which the Information Server data is retrieved.
2. Display of the available equipment and KPIs in the selected project.
3. Selection of the time range from which the calculated data is requested.
   Note: You can reference cells in the spreadsheet instead of entering the date. Set the following date format for the respective cells: "DD:MM:YYYY HH:MM:SS".
4. Specifies the cell to which the calculated KPI value is written.
5. Specifies the cells to which the additional information of the KPI is written (optional). You can use this additional information to implement titles, for example.

Requirement

- The Excel add-in is installed.
- The Information Server is available.
- The URL of the Information Server is known.
- Microsoft Excel is open.

Procedure

1. Enter the connection data of the Information Server.
2. If you want to use an existing report template:
   - Click "Download from IS"
     The "Download from IS Server" dialog opens.
   - Navigate to the required folder under "Folders".
   - Select the required template under "Templates".
3. Select the KPIs whose results you want to display:
   - Click "Add/Edit". The "Add or change Key Performance Indicators" dialog opens.
   - Select the project whose data you want to display.
   - Select the KPIs for each equipment whose calculation results you want to display.
   - Assign the time period to each KPI under "Selected indicators" as well as the cell in which the calculated value is displayed.

4. To save the report result:
   - Click "Upload to IS". The "Download from IS Server" dialog opens.
   - Navigate to the required folder under "Folders".
   - Enter the name of the template under "Template name".

See also
Creating a PerformanceMonitor report in the Information Server (Page 128)

3.4.7.3 Creating a custom template

Introduction
When you install the PerformanceMonitor on a computer with an Information Server installation, you can create custom templates for reports. The database of the Information Server contains procedures that you can use to access the data of the PerformanceMonitor.

To create such a template, you need the "Business Intelligence Development Studio" development environment. You can use an existing template from the Information Server as a basis for the template.

"Dataset" object
In order to use the data from the PerformanceMonitor in the custom template, you need "Dataset" type objects with the following names:

- "Results": Contains the calculation results
- "Equipments": Contains the IDs of the equipment (optional)
- "KPIs": Contains the names of the KPIs (optional)
- "Operands": Contains the names of the operands (optional)

You create the content for each of these objects with an SQL query from the PerformanceMonitor database.
**SQL queries for filling out the "Dataset" type objects**

You can fill out the "Results" with the following SQL query:

```sql
exec PM.udsp_TCCalculateKPIWithLCID @eqIds, @kpiNames, @operandNames, @from, @to, @filter, @context, @lcid
```

You can fill out "Equipments" with the following SQL queries:

```sql
exec PM.udsp_TCGetAllEquipmentsWithLCID 1033
```

You can fill out the "KPIs" with the following SQL query:

```sql
exec pm.udsp_TCGetKPINamesOfEquipmentsWithLCID @eqId, 1033
```

You can fill out the "Operands" with the following SQL query:

```sql
exec PM.udsp_TCGetOperandNamesOfEquipmentsWithLCID @eqId, 1033
```

**See also**

Step 2: Creating and publishing a template (Page 141)

### Example: Creating a custom template for outputting KPIs

**Task**

This example shows you how you can create a custom template for the information server on the basis of an existing template. The "Availability" KPI for all available equipment is queried in this template.

The template is created in the "SQL Server Business Intelligence Development Studio" development environment. You can find additional information in the Internet ([http://technet.microsoft.com/de-de/library/ms173767%28v=sql.105%29.aspx](http://technet.microsoft.com/de-de/library/ms173767%28v=sql.105%29.aspx)).
Requirement

- The following applications are installed on your computer:
  - PerformanceMonitor IS Templates
  - Information server
  - SQL Server Business Intelligence Development Studio (version 2008 or later)
- You need to be familiar with the "SQL Server Business Intelligence Development Studio".

Overview of the steps involved

Step 1: Creating a Report server project
1. Creating a Report server project
2. Defining a data source
3. Integrating the existing template into the project
4. Preparing a template
Step 2: Creating and publishing a template
1. Creating an "Equipment" dataset
2. Creating a "Results" dataset
3. Configuring the output of the calculated data
4. Testing the template (optional)
5. Publishing the template on the Information server
6. Creating a report

See also

Step 1: Creating a Report server project (Page 137)
Step 2: Creating and publishing a template (Page 141)
Step 1: Creating a Report server project

Creating a Report server project

1. Start the "SQL Server Business Development Intelligence Studio".
2. Create a new project using the menu command "File > New > Project...", for example "CustomReports".
   - Select "Business Intelligence Projects" as the project type.
   - Select "Report Server Project" as the template.
   - Select ".NET Framework 3.5".

![Creating a Report server project](image-url)
Defining a data source

1. Select the "Add New Data Source" command from the shortcut menu of "Shared Data Sources" in the "Solution Explorer".

   ![Solution Explorer](image)

   The "Shared Data Source Properties" dialog opens.

2. Enter a name and select "Microsoft SQL Server" as the type.

3. Use "Edit..." to define the "Connection String".

   The "Connection Properties" dialog opens.
   - Select the computer on which the Information server is installed under "Server name".
   - Activate "Use Windows Authentication".
   - Select the entry "Webframe" as the database name.

   ![Connection Properties](image)
Interim result: The "Connection String" is entered.
Integrating the existing template into the project

1. Select the "Add > Existing Item..." command from the shortcut menu of "Reports" in the "Solution Explorer".

The "Add Existing Item - <Project designation>" dialog opens.

2. Select the desired template, for example "PerfViewKpi.rdl" in the "PerformanceMonitor" directory of the installation directory of the Information server.

3. Delete the unneeded "Parameters" and "Datasets" in the copy as shown in the following figure.

![Status before deleting the unneeded "Parameters" and "Datasets"](image1)

![Status after deleting](image2)

① Status before deleting the unneeded "Parameters" and "Datasets"

② Status after deleting

Note

Displaying the report preview in the development environment

Enter the proxy catalog name of the Information server in the Report server project to ensure that the correct preview is displayed in the development environment under "Preview" instead of an error message.

You can find additional information in the “Testing a template” section under "Step 2: Creating and publishing a template (Page 141)".
Result

The Report server project has been created. The next step involves creating the template and publishing it on the Information server.

See also

Example: Creating a custom template for outputting KPIs (Page 134)

Step 2: Creating and publishing a template

Requirement

"Step 1" of the example has been completed.

Creating an "Equipment" dataset

The following Query is used to fill out the "Equipments" Dataset with the equipment available in the database:

DECLARE @RC int
DECLARE @storedProcedure nvachar(256)
SET @storedProcedure = '\[' + @Catalog + '\].PM.udsp_TCGetAllEquipmentsWithLCD'
EXECUTE @RC = @storedProcedure 1033

1. Select the "Add Dataset" command from the shortcut menu of "Datasets" in the "Report Data" area. The "Dataset Properties" dialog opens.
2. Enter "Equipments" as the name under "Query".
3. Under "Query Type", select the "Text" option and enter the "Query" shown above.
Creating a "Results" dataset

The following query creates a table in the "Results" Dataset, which is filled out with the data available in the PerformanceMonitor. You can use this table to make SQL queries for data relevant for the template.

DECLARE @sp nvarchar(256)
DECLARE @operandNames nvarchar(max)
SET @sp = N'[' + @Catalog + N'].FM.udsp_TCCalculateKPIWithLCID'
SET @operandNames = N''
DECLARE @table table (eqId uniqueidentifier, eqName varchar(256), eqDisplay nvarchar(256), eqForecolor nvarchar(100), eqBackcolor nvarchar(100), eqComment nvarchar(max), eqToolTip nvarchar(256), resId uniqueidentifier, resName nvarchar(256), resDisplayName nvarchar(256), resType int, resValue float, resMax float, resMin float, resGroup nvarchar(256), resBackcolor nvarchar(100), resForecolor nvarchar(100), resFormula nvarchar(max), resAxis nvarchar(256), resFrom datetime, resTo datetime, resUnit nvarchar(50), resComment nvarchar(max), resToolTip nvarchar(256), detId uniqueidentifier, detName nvarchar(256), detDisplayName nvarchar(256), detType int, detValue float, detMax float, detMin float, detGroup nvarchar(100), detBackcolor nvarchar(100), detForecolor nvarchar(100), detAxis nvarchar(256), detUnit nvarchar(100), detComment nvarchar(max), detToolTip nvarchar(256))
INSERT INTO @table EXEC @sp @eqIds, @kpiNames, @operandNames, @from, @to, @filter, @context, @lcid

1. Select the "Add Dataset" command from the shortcut menu of "Datasets" in the "Report Data" area.
   The "Dataset Properties" dialog opens.
2. Enter "Results" as the name under "Query".
3. Under "Query Type", select the "Text" option and enter the "Query" shown above.
4. Define the following parameters under "Parameter":

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>@eqIds</td>
<td>=Join(Parameters!Equipments.Value, &quot;,&quot;) 1</td>
</tr>
<tr>
<td>@Catalog</td>
<td>=Parameters!Catalog.Value 1</td>
</tr>
<tr>
<td>@kpiNames</td>
<td>Availability</td>
</tr>
<tr>
<td>@from</td>
<td>=Parameters!TimeBegin.Value 1</td>
</tr>
<tr>
<td>@to</td>
<td>=Parameters!TimeEnd.Value 1</td>
</tr>
<tr>
<td>@filter</td>
<td>=String.Empty 1</td>
</tr>
<tr>
<td>@context</td>
<td>=String.Empty 1</td>
</tr>
<tr>
<td>@lcid</td>
<td>1033 2</td>
</tr>
</tbody>
</table>

1 Enter this expression via the "Expression" dialog.
2 Language ID for English

Interim result:
5. Close the "Dataset Properties" dialog. The "Equipments" parameter is automatically created under "Parameters" in the "Report Data" area.

6. Open the "Equipments" parameter and configure the parameter as shown below:

![Image of parameter configuration]

**Configuring the output of the calculated data**

You can use a table to output the "Availability" KPI for the selected equipment in the template. You can also set the availability graphically using a bar.

1. Insert the "Table" Control with three columns in "Visual Studio Toolbox".
2. Connect the first two columns as follows:
   - Column 1: [eqDisplayName]
   - Column 2: [resValue]
3. Insert the "DataBar" Control in the third column.
4. Connect the "DataBar" Control to [resValue].

Interim result:
Testing the template (optional)

Before you publish the template on the website of the Information server, you should test its functionality using the preview function. The following steps are required for the preview to be displayed correctly in the development environment:

1. Copy the "Siemens.InformationServer.Common.ExternalResources.dll" class library from the installation directory of the Report server into the following directory:
   - "Program Files (x86)\Microsoft Visual Studio 9.0\Comon 7\IDE\Private Assemblies"

2. Add the reference to the class library in the "CustomReports" project:
   - Select the "Reports" entry under "Properties".
   - Under "Assemblies", create the reference to the class library from the "Private Assemblies" directory.
3. Enter the static name of the data source for the PerformanceMonitor data:
   
   - Under "Report Data", open the "@Catalog" object under "Parameters". The "Report Parameter Properties" dialog opens.
   - Under "Default Values", use the "Expression" dialog to enter the following expression: 
     
     "=ISProxy_1".
– Comment out the existing expression:

Note: If you do not know the name of the proxy catalog, connect to the instance of the SQL Server in the SQL Server Management Studio. You can determine the name of the proxy catalog there:
4. Switch to the "Preview" tab.
5. Select the desired equipment and click on "View Report".

Interim result:

![Performance Monitor: Availability]

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Availability in %</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 Accumulator</td>
<td>19.59%</td>
</tr>
<tr>
<td>02 CapApplicator</td>
<td>17.56%</td>
</tr>
<tr>
<td>03 StrawApplicator</td>
<td>82.57%</td>
</tr>
<tr>
<td>04 MultiShrink</td>
<td>18.74%</td>
</tr>
</tbody>
</table>

Report created: 2/7/2014 9:17:13 AM
Publishing the template on the Information server

1. When you have tested the template in the development environment:
   - Under "Report Data", open the "@Catalog" object under "Parameters". The "Report Parameter Properties" dialog opens.
   - Under "Default Values", use the "Expression" dialog to delete the "=ISProxy_1" expression or comment it out.
   - Comment the "=Code.GetProjectCatalog(Parameters!Project.Value)" expression back in again.

2. Log on to the Information server.

3. Press "Upload" to load the newly created template to the folder of your choice.

SIEMENS SIMATIC Information Server
Creating a report

1. Finally, create the report.

See also

Creating a custom template (Page 133)
Step 1: Creating a Report server project (Page 137)
Example: Creating a custom template for outputting KPIs (Page 134)
3.5 Reference

3.5.1 Syntax for formulas

Syntax

<Operand>[Operator]<Operand>

Arithmetic operators

The following arithmetic operators are permitted:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
</tr>
<tr>
<td>exp</td>
<td>Exponential function</td>
</tr>
<tr>
<td>pow</td>
<td>Power function</td>
</tr>
</tbody>
</table>

Logic operators

The following logical operators are permitted:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;&amp;</td>
<td>Logical AND operation</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>Negation</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>=</td>
<td>Equal to</td>
</tr>
</tbody>
</table>
3.5.2 PerformanceMonitor Configuration Studio

3.5.2.1 Types

Name

Uniquely identifies the object within the PerformanceMonitor Configuration Studio and is language-neutral.

Use the following characters: "A...Z", "0...9" and ".".

See also

PerformanceMonitor Configuration Studio (Page 35)

Grouping

Defines an item of equipment as an equipment group or assigns the equipment to an existing equipment group.

When you create new equipment, the equipment is assigned by default to the group "Not assigned".

Calculation formula

Shows the formula for calculating the KPI type.

You can edit the formula in the formula editor.

Evaluation type

Defines the purpose of the operand type:

- Timer/Counter: Time series analysis. The time series analysis is used to determine how long or how often a value has changed.
- Number: Value analysis. Value analysis is used to compress or calculate recorded values from a time period, e.g. for averaging or summation.
- <Structured operand list>: Defines the operand type as "Structured operand type".

Note

If you acquire the values of an external counter in an operand, select "Number".

See also

Calculation mode (Page 156)
Unit
Defines an arbitrary unit for the object.
The unit is exclusively used as additional information. During calculations, ensure that the
dimensions of the operands and KPIs in question are correct.

Data type (operand formula)
Defines the data type of the parameter.
The value of the WinCC tag must match the data type of the parameter.

Status
Defines the status value of a structured operand.
You assign a value range to each status.

See also
MinMax (Page 153)

MinMax
Defines the value range for the list entry of a structured operand.
The value ranges of multiple list entries should not overlap. Negative values are not permissible.
The following table shows a permissible value definition for list entries:

<table>
<thead>
<tr>
<th>Status</th>
<th>Min.</th>
<th>Max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Off</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Error</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td>Unknown</td>
<td>11</td>
<td>256</td>
</tr>
</tbody>
</table>

See also
Status (Page 153)

Data type (context information)
Defines the data type of the WinCC tag from which the context information is read in Runtime.
If you enter the list entries for context information in the PerformanceMonitor Configuration Studio, the data type is not evaluated.

Title
Defines a list entry for context information.
The list entry is language-neutral.

Display name
Language-dependent display name for the object in Runtime.
The specified name is stored in the text library.
You select the configuration language under "View > Languages".

Comment
Language-dependent comment for an object type.
The comment is displayed only in the PerformanceMonitor Configuration Studio.
This column is hidden by default.

See also
Display name (Page 154)

Tooltip
Language-dependent tooltip for an object type.
The tooltip is displayed only in Runtime.
This column is hidden by default.

See also
Display name (Page 154)

Bar color
Bar color with which the object is displayed in Runtime or with which a report is displayed graphically.
This column is hidden by default.

Text color
Text color with which the labels are displayed in Runtime or with which a report is displayed graphically.
This column is hidden by default.
3.5.2.2 Instances

Connection mode
Type of data supply.
Specifies the type of data source, e.g. WinCC tag or constant.

See also
Data source (Page 155)

Connect with

See also
Connection mode (Page 155)

Data source
Value of an operand or context information instance.
The value you can enter depends on the "Connection mode":
• WinCC tag
• Constant
• Formula (operand only)
• Entry list (context information only)
For operands with the "Timer/Counter" evaluation type, enter the limit or range using this field.

See also
Evaluation type (Page 152)
Connection mode (Page 155)
Data type (operand instance) (Page 155)

Data source cycle
Cycle with which the value under "Data source" is queried.
All cycles defined in WinCC are available.

Data type (operand instance)
Data type of the operand.
The value under "Data source" must match the data type.

See also

Data source (Page 155)

Calculation mode

Evaluation rule for the operand.
The evaluation rule depends on the "Evaluation type":

- "Evaluation type" = "Number"
  Performs a calculation for an evaluation over the specified time period:

<table>
<thead>
<tr>
<th>Calculation mode</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum</td>
<td>Returns the maximum detected value from the specified time period.</td>
</tr>
<tr>
<td>Minimum</td>
<td>Returns the smallest recorded value from the specified time period.</td>
</tr>
<tr>
<td>Average</td>
<td>Returns the average of all recorded values from the specified time period.</td>
</tr>
<tr>
<td>Sum</td>
<td>Returns the sum of all recorded values from the specified time period.</td>
</tr>
<tr>
<td>Product</td>
<td>Returns the product of all recorded values from the specified time period.</td>
</tr>
<tr>
<td>External counter</td>
<td>The operand gets its value from an &quot;external counter&quot;, which is processed in the controller, e.g. Count or Reset. Assign parameters to the counting in the object properties of the operand.</td>
</tr>
</tbody>
</table>

- "Evaluation type" = "Timer/Counter"
  Defines a condition that is interpreted as an edge change of a state.
Enter the limit or area of the edge change under "Data source".
A pending value is evaluated based on the specified condition. The following must apply in order to the value with time stamp:
  - The defined condition is true.
  - An edge transition has occurred.

See also

Evaluation type (Page 152)
Settling time (seconds) (Page 156)
Example: Using an operand of the type "External counter" (Page 86)

Settling time (seconds)

Switching time.
A value must be present for at least the time specified before the condition under "Calculation mode" is evaluated.
The switching time must be greater than or equal to the cycle time under "Data source cycle".

See also
Calculation mode (Page 156)
Data source cycle (Page 155)

3.5.3 VBS Reference

3.5.3.1 Methoden

GetEquipmentCollection method

Function
Returns the list of all equipment objects of the specified control as "ICCxAxCollection" type.

Syntax
Expression.GetEquipmentCollection()

Expression
Required. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCxAxCollection
The following properties are available for the ICCxAxCollection:
- Count
- Item

The following methods are available for the ICCxAxCollection:
- AddItem(vName) As Object
- RemoveItem(vIndex)
Example

Dim perfCtrl
Dim equipments
Dim eq
Set perfCtrl = ScreenItems("Control2")
Set equipments = perfCtrl.GetEquipmentCollection
For Each eq in equipments
    If eq.Name = "MultiShrink" Then
        equipments.removeItem(eq.Name)
    End If
Next
equipments.AddItem("QualityRate")

See also

Access PerformanceMonitor controls with VBS (Page 92)

GetKPIValueCollection method

Function

Returns the list of all KPI objects of the specified control as "ICCAxCollection" type.

Syntax

Expression.GetKPIValueCollection()

Expression

Required. An expression that returns an object of the "ScreenItem" type.

Parameters

--

Features and functions of the ICCAxCollection

The following properties are available for the ICCAxCollection:

- Count
- Item

The following methods are available for the ICCAxCollection:

- AddItem(vName) As Object
- RemoveItem(vIndex)
Example

Dim perfCtrl
Dim kpis
Dim kpi
Set perfCtrl = ScreenItems("Controll")
Set kpis = perfCtrl.GetKPICollection
For Each kpi in kpis
  If kpis.Name = "MultiShrink" Then
    kpis.removeItem(kpis.Name)
  End If
Next
kpis.AddItem("QualityRate")
perfCtrl.ReloadData

See also

Access PerformanceMonitor controls with VBS (Page 92)

GetOperandCollection method

Function

Returns the list of all operand objects of the specified control as "ICCAxCollection" type.

Syntax

Expression.GetOperandCollection()

Expression

Required. An expression that returns an object of the "ScreenItem" type.

Parameters

--

Features and functions of the ICCAxCollection

The following properties are available for the ICCAxCollection:

- Count
- Item

The following methods are available for the ICCAxCollection:

- AddItem(vName) As Object
- RemoveItem(vIndex)
Example

Dim perfCtrl
Dim operands
Dim op
Set perfCtrl = ScreenItems("Control2")
Set operands = perfCtrl.GetOperandCollection
For Each op in operands
    If op.Name = "OperatingTime.Time" Then
        operands.removeItem(op.Name)
    End If
Next
perfCtrl.ReloadData

See also

Access PerformanceMonitor controls with VBS (Page 92)

GetSpecFilterCollection method

Function

Returns the list of all filters of the specified control as "ICCAxCollection" type.

Syntax

Expression.GetSpecFilterCollection()

Expression

Required. An expression which returns a "ScreenItem" type object.

Parameters

--

Features and functions of the ICCAxCollection

The following properties are available for the ICCAxCollection:

- Count
- Item

The following methods are available for the ICCAxCollection:

- AddItem(vName) As Object
- RemoveItem(vIndex)
Example

Dim perfCtrl
Dim specifications
Dim filterItem

Set perfCtrl = ScreenItems("Control2")
Set specifications = perfCtrl.GetSpecFilterCollection()
Set filterItem = specifications.AddItem(“FilterEqualsTo”)

With filterItem
  .SpecId = ”Supplier”
  .Operator = 0
  .Operand = ”Siemens”
End With

See also
- SpecId property (Page 168)
- Operator property (Page 167)
- Operand-property (Page 167)
- LogicOP property (Page 167)
- Access PerformanceMonitor controls with VBS (Page 92)

GetTimeFrameCollection method

Function

Returns the list of all time ranges of the specified control as “ICCAxCollection” type.

Syntax

Expression.GetTimeFrameCollection()

Expression

Required. An expression which returns a ”ScreenItem” type object.

Parameter

- -
Features and functions of the ICCAxCollection

The following properties are available for the ICCAxCollection:

- Count
- Item

The following methods are available for the ICCAxCollection:

- AddItem(vName) As Object
- RemoveItem(vIndex)

Example

```vbscript
Dim perfCtrl
Dim Timeframes
Dim timeframe

Set perfCtrl = ScreenItems("Control2")
Set Timeframes = perfCtrl.GetTimeFrameCollection()

For Each timeframe In Timeframes
    Timeframes.RemoveItem(timeframe.Name)
Next

Timeframes.AddItem("Reference Time with fixed length")
Set TimeframeItem = Timeframes("Reference Time with fixed length")

With perfCtrl
    .TimeframeMode = 3
    .TimeframeBegin = CDate("7/30/2014 03:00:00 PM")
    .TimeframeLength = 3
    .TimeframeLengthUnit = 2
    .IntervalMode = 1
    .IntervalCount = 3
End With
```

See also

- IntervalMode property (Page 165)
- IntervalCount property (Page 165)
- IntervalLength property (Page 166)
- IntervalLengthUnit property (Page 166)
- TimeframeBegin property (Page 168)
- TimeframeEnd property (Page 168)
- TimeframeInPast property (Page 169)
- TimeframeInPastUnit property (Page 169)
- TimeframeLength property (Page 169)
Export method

Function
Executes the "Export" key function of the specified control.

Syntax
Ausdruck.Export()

Expression
Required. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

ShowHelp method

Function
Executes the "Help" key function of the specified control.

Syntax
Ausdruck.ShowHelp()

Expression
Required. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

ShowPropertyDialog method

Function
Executes the "Configuration dialog" key function of the specified control.
Syntax

Expression.ShowProperty-Dialog()

Expression
Required. An expression that returns an object of the "ScreenItem" type.

Parameters

3.5.3.2 Properties

A - K

BeginGroup property

Function

Returns the current status of a button in the toolbar. BOOLEAN. Read access.
TRUE, if the object belongs to a group.

BarSortModeOperand property

Function

Defines the sorting of the operand bar or returns the value. Value range 0-3. Write/read access.
0=Manual
1=Value, ascending
2=Value, descending
3=Alphabetic

BarSortModeKPI property

Function

Defines the sorting of the KPI bar or returns the value. Value range 0-3. Write/read access.
0=Manual
1=Value, ascending
2=Value, descending
3=Alphabetic

**ContextGroupBy property**

**Function**

Defines the value according to which the context information for the specified object is grouped or returns the set value. STRING. Write/read access.

**IconID property**

**Function**

Returns the ID of an icon in the status bar. LONG. Read access.

**IntervalMode property**

**Function**

Defines whether the data of a time range is queried in intervals or returns the value. Value range: 0-2. Write/Read access.

0=No intervals
1=A specific number of intervals
2=A specific time period for intervals

**See also**

GetTimeFrameCollection method (Page 161)

**IntervalCount property**

**Function**

Defines the number of intervals with which a time range is queried or returns the value. LONG. Write/read access.
See also

GetTimeFrameCollection method (Page 161)

**IntervalLength property**

**Function**

Defines the length of the intervals with which a time range is queried or returns the value. LONG. Write/read access.

See also

GetTimeFrameCollection method (Page 161)

**IntervalLengthUnit property**

**Function**

Defines the unit for the duration of the intervals with which a time range is queried or returns the value. Value range 0-3. Write/read access.

0=Seconds
1=Minutes
2=Hours
3=Days

See also

GetTimeFrameCollection method (Page 161)

**L - Z**

**Locked property**

**Function**

Returns the current status of a button in the toolbar. BOOLEAN. Read access.

TRUE, if the object is disabled.
LogicOP property

Function
Returns the value for a logic operation. Value range 0-4. Read access.
0=None
1=OPEN PAREN
2=CLOSE PAREN
3=AND
4=OR

See also
GetSpecFilterCollection method (Page 160)

Operand-property

Function
Defines the specified value as filter or returns the value set as filter. STRING. Write/read access.

See also
GetSpecFilterCollection method (Page 160)

Operator property

Function
Returns the value for a logical comparison operator. Value range 0-6. Read access.
0=EQUAL
1=NOTEQUAL
2=LESS
3=LESSOREQUAL
4=GREATER
5=GREATEROEQUAL
6=LIKE
See also

GetSpecFilterCollection method (Page 160)

**SpecId property**

**Function**

Returns the ID of the specified "DataItem" object configured in the project (product ID, manufacturer ID). STRING. Read access.

See also

GetSpecFilterCollection method (Page 160)

**TimeframeBegin property**

**Function**

Defines the start time for the calculation and display of data or returns the value. DATE. Write/read access.

See also

GetTimeFrameCollection method (Page 161)

**TimeframeEnd property**

**Function**

Defines the end point for the calculation and display of data or returns the value. DATE. Write/read access.

See also

GetTimeFrameCollection method (Page 161)
TimeframeInPast property

Function

Defines the length of the offset of a time range in the past or returns the value. LONG. Write/read access.

See also

GetTimeFrameCollection method (Page 161)

TimeframeInPastUnit property

Function

Defines the time unit for the offset of a time range in the past or returns the value. Value range: 0-3. Write/Read access.

0=Seconds
1=Minutes
2=Hours
3=Days

See also

GetTimeFrameCollection method (Page 161)

TimeframeLength property

Function

Defines the length of the time range for the calculation and display of data or returns the value. LONG. Write/read access.

See also

GetTimeFrameCollection method (Page 161)
TimeframeLengthUnit property

Function

Defines the time unit for the definition of a time range or returns the value. Value range: 0-3. Write/Read access.

0=Seconds
1=Minutes
2=Hours
3=Days

See also

GetTimeFrameCollection method (Page 161)

TimeframeMode property

Function

Defines the mode in which the data of the configured time range is queried or returns the value. Value range: 0-3. Write/Read access.

0=Start and end time
1=Start time and duration
2=Duration with relative start time
3=Duration with reference time

See also

GetTimeFrameCollection method (Page 161)

UseDefaultBackColor property

Function

Defines whether the standard background color is used for the specified object or returns the value. BOOLEAN. Write/read access.

TRUE: The standard background color is used.
FALSE: The user-defined background color is used.
UseDefaultForeColor property

Function

Defines whether the standard foreground color (text color) is used for the specified object or returns the value. BOOLEAN write-read access.

TRUE: The standard foreground color is used.
FALSE: The user-defined foreground color is used.

UserDefined property

Function

Returns a value which shows whether the specified button was enabled or disabled by the user. BOOLEAN. Read access.

TRUE if the button was enabled or disabled by the user.
Index

A
Access
  controls with VBS, 92
Archive segment, 57

B
Backup file, 59
BarSortModeKPI
  Properties in VBS, 164
BarSortModeOperand
  Properties in VBS, 164
Basics
  Configuration data, 88
BeginGroup
  Properties in VBS, 164

C
Compression, 55
Configuration data
  Basics, 88
  Edit, 89
  Exporting, 90
  Importing, 91
  validation, 89
ContextGroupBy
  Properties in VBS, 165
Controls
  Sorting KPIs, 99
  Sorting operands, 99
Customer support, (See support)

D
Dashboard
  Overview, 48
Data sources, 52
Database
  Backup, 61
  recovering, 64
Database backup
  Automatic, 62
  Manual, 62
  Path, 63
  Storage, 63
  Storage medium, 64
Delayed segments, 57

E
Edit
  Configuration data, 89
Error report, (See support)
Excel add-in
  Output KPIs, 132
Export
  Methods in VBS, 163
Exporting
  Configuration data, 90

F
FAQ, (See support)
Filtering
  context information in the PerformanceViewControl, 99
Future segment, 54

G
GetEquipmentCollection, 157
  Methods, 157
GetKPICollection, 158
  Methods, 158
GetOperandCollection, 159
  Methods, 159
GetSpecFilterCollection, 160
  Methods, 160